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Historia is an digital currency paired with a data storage system (IPFS) that allows for eternal histoical record storage. Additionally, Historia is a consensus-based, immutable historical record blockchain system designed for record
keeping of current events (future history) with emphasis on absolute accuracy and seeks to prevent all assimilations of
falsehoods into the historical record. The Historia project is based on the Bitcoin and the Dash project. The Historia
project builds on Dash’s masternode system to implement IPFS to offer decentralized record storage and voting of
said records via the masternode voting system. Like Dash, Historia currently also offers instant transactions, private
transactions and operates a self-governing and self-funding model that enables the Historia network to pay individuals
and businesses for proposals and records that adds value to the network and the immutable record storage system.
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1.1 What is Historia?
Historia aims to be a consesus based historical record database. The Historia network features record storage via
IPFS and consesus based voting of records to prevent falsehoods from entering in the historical record. The current
version of Historia was built on Dash 12.2.3 and inherents advanced features from Dash such as: instant transaction
confirmation, double spend protection, anonymity equal to that of physical cash, a self-governing, self-funding model
driven by incentivized full nodes and a clear roadmap.
The links and documentation collected here can help you get started. You may also use the table of contents on the left
to find a specific topic of interest. New users may be interested in getting started with an appropriate wallet, or joining
one of the many Historia community sites.

1.1.1 Whitepaper
The Historia Whitepaper describes the unique value proposition and key innovations in Historia from an academic and
theoretical perspective.
• Latest whitepaper
• PDF whitepaper

1.1.2 Roadmap
The Historia Roadmap sets out delivery milestones for future releases of Historia and includes specific technical
details describing how the development team plans to realise each challenge. Like the Whitepaper, it is versioned and
maintained as a project on GitHub.
• Historia Roadmap
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1.2 Links and Information
1.2.1 Links
Official sites
• Website: https://historia.network
• User documentation: https://docs.historia.network
• GitHub: https://github.com/HistoriaOffical
• Roadmap: https://historia.network/#roadmap
Forums
• BitcoinTalk thread: https://bitcointalk.org/index.php?topic=5010022
• Have another site? Contact us at info@historia.network to get listed here.
Chat
• Historia Offical Chat Discord: https://discordapp.com/invite/b3FJPpn
Social media
• Reddit: https://www.reddit.com/r/Historiasys
• Twitter: https://twitter.com/historiasys
• YouTube: https://www.youtube.com/channel/UCG5l1dx6p9gPJut0W-Val0g
• Blog: http://blog.historia.network/
• Medium: https://medium.com/@historiasys
• Github: https://github.com/HistoriaOffical/

1.2.2 Tools
Block explorers, statistics and visualizations
• http://blockexplorer.historia.network
Masternode management
• https://historia.network/governance
Price monitoring and statistics
• https://delta.app/en
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1.2.3 Mobile Apps
Android
• Historia Wallet: https://play.google.com/store/apps/details?id=historia.historia.wallet

1.3 Wallets
Whenever you are storing objects with a market value, security is necessary. This applies to barter systems as well as
economies using currency as a medium of exchange. While banks store balances on a private ledger, cryptocurrencies
store balances under unique addresses on a distributed public ledger. The cryptographic private keys to access the
balance stored on each public address are therefore the object of value in this system. This section of the documentation
discusses different practical methods of keeping these keys safe in wallets, while remaining useful for day-to-day
needs.

1.3.1 Historia Core Wallet
Historia Core Wallet is the full official release of Historia and supports all Historia features as they are released.
Current support includes IPFS, Record and Proposal Storage, InstantSend and PrivateSend, as well as an RPC console
and governance features. Historia Core Wallet (sometimes known as the QT wallet) is a professional or heavy wallet
which downloads the full blockchain (several GB in size). The Historia Core Wallet also includes the IPFS record and
proposal database, and can operate as both a full node and masternode on the network. Because of the requirement
to hold a full copy of the blockchain, some time is required for synchronization when starting the wallet. Once this
is done, the correct balances will be displayed, and the functions of the wallet can be used. Historia Core Wallet is
available for macOS, Linux, and Windows.
Features:
• IPFS Intregration
• Record and Proposal Database storage
• PrivateSend
• InstantSend
• Wallet encryption
• Coin control and fee control
• QR code generation and address book
• Masternode commands and voting
• Automated backup
• Debug console
Available documentation:
Installation
Coming soon.

1.3. Wallets
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Arguments and commands
All command-line options (except for -datadir and -conf) may be specified in a configuration file, and all configuration file options may also be specified on the command line. Command-line options override values set in the
configuration file. The configuration file is a list of setting=value pairs, one per line, with optional comments
starting with the # character.
The configuration file is not automatically created; you can create it using your favorite plain-text editor. By default,
historia-qt (or historiad) will look for a file named historia.conf in the historia data directory, but both the data
directory and the configuration file path may be changed using the -datadir and -conf command-line arguments.
Note: if running Historia in testnet mode, the sub-folder testnet3 will be appended to the data directory automatically.
Command line arguments
These commands are accurate as of Historia Core version 0.16.3.0.
• historiad
• historia-qt
• historia-cli
• historia-tx
historiad
Historia Core Daemon
Usage
historiad [options] Start Historia Core Daemon
Options
--help

Print this help message and exit

--version

Print version and exit

--alerts

Receive and display P2P network alerts (default: 1)

--alertnotify=<cmd> Execute command when a relevant alert is received or we see a really long fork
(%s in cmd is replaced by message)
--blocknotify=<cmd> Execute command when the best block changes (%s in cmd is replaced by block
hash)
--assumevalid=<hex> If this block is in the chain assume that it and its ancestors are valid
and potentially skip their script verification (0 to verify all, default:
00000000000000b4181bbbdddbae464ce11fede5d0292fb63fdede1e7c8ab21c,
testnet: 00000ce22113f3eb8636e225d6a1691e132fdd587aed993e1bc9b07a0235eea4)

6

--conf=<file>

Specify configuration file (default: historia.conf)

--daemon

Run in the background as a daemon and accept commands
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--datadir=<dir>

Specify data directory

--dbcache=<n>

Set database cache size in megabytes (4 to 16384, default: 100)

--loadblock=<file>

Imports blocks from external blk000??.dat file on startup

--maxorphantx=<n> Keep at most <n> unconnectable transactions in memory (default: 100)
--maxmempool=<n> Keep the transaction memory pool below <n> megabytes (default: 300)
--mempoolexpiry=<n> Do not keep transactions in the mempool longer than <n> hours (default: 72)
--blockreconstructionextratxn=<n> Extra transactions to keep in memory for compact block reconstructions (default: 100)
--par=<n>

Set the number of script verification threads (-1 to 16, 0 = auto, <0 = leave that
many cores free, default: 0)

--pid=<file>

Specify pid file (default: historiad.pid)

--prune=<n>

Reduce storage requirements by enabling pruning (deleting) of old blocks. This
allows the pruneblockchain RPC to be called to delete specific blocks, and enables automatic pruning of old blocks if a target size in MiB is provided. This
mode is incompatible with -txindex and -rescan. Warning: Reverting this setting requires re-downloading the entire blockchain. (default: 0 = disable pruning
blocks, 1 = allow manual pruning via RPC, >945 = automatically prune block
files to stay under the specified target size in MiB)

--reindex-chainstate Rebuild chain state from the currently indexed blocks
--reindex

Rebuild chain state and block index from the blk*.dat files on disk

--sysperms

Create new files with system default permissions, instead of umask 077 (only
effective with disabled wallet functionality)

--txindex

Maintain a full transaction index, used by the getrawtransaction rpc call (default:
1)

--addressindex

Maintain a full address index, used to query for the balance, txids and unspent
outputs for addresses (default: 0)

--timestampindex

Maintain a timestamp index for block hashes, used to query blocks hashes by a
range of timestamps (default: 0)

--spentindex

Maintain a full spent index, used to query the spending txid and input index for
an outpoint (default: 0)

Connection options
--addnode=<ip>

Add a node to connect to and attempt to keep the connection open

--allowprivatenet

Allow RFC1918 addresses to be relayed and connected to (default: 0)

--banscore=<n>

Threshold for disconnecting misbehaving peers (default: 100)

--bantime=<n>

Number of seconds to keep misbehaving peers from reconnecting (default:
86400)

--bind=<addr>

Bind to given address and always listen on it. Use [host]:port notation for IPv6

--connect=<ip>

Connect only to the specified node(s); -noconnect or -connect=0 alone to disable
automatic connections

1.3. Wallets
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--discover

Discover own IP addresses (default: 1 when listening and no -externalip or proxy)

--dns

Allow DNS lookups for -addnode, -seednode and -connect (default: 1)

--dnsseed

Query for peer addresses via DNS lookup, if low on addresses (default: 1 unless
-connect/-noconnect)

--externalip=<ip>

Specify your own public address

--forcednsseed

Always query for peer addresses via DNS lookup (default: 0)

--listen

Accept connections from outside (default: 1 if no -proxy or -connect)

--listenonion

Automatically create Tor hidden service (default: 1)

--maxconnections=<n> Maintain at most <n> connections to peers (temporary service connections
excluded) (default: 125)
--maxreceivebuffer=<n> Maximum per-connection receive buffer, <n>*1000 bytes (default: 5000)
--maxsendbuffer=<n> Maximum per-connection send buffer, <n>*1000 bytes (default: 1000)
--maxtimeadjustment Maximum allowed median peer time offset adjustment. Local perspective of
time may be influenced by peers forward or backward by this amount. (default:
4200 seconds)
--onion=<ip:port>

Use separate SOCKS5 proxy to reach peers via Tor hidden services (default: proxy)

--onlynet=<net>

Only connect to nodes in network <net> (ipv4, ipv6 or onion)

--permitbaremultisig Relay non-P2SH multisig (default: 1)
--peerbloomfilters

Support filtering of blocks and transaction with bloom filters (default: 1)

--port=<port>

Listen for connections on <port> (default: 9999 or testnet: 19999)

--proxy=<ip:port>

Connect through SOCKS5 proxy

--proxyrandomize

Randomize credentials for every proxy connection. This enables Tor stream isolation (default: 1)

--seednode=<ip>

Connect to a node to retrieve peer addresses, and disconnect

--timeout=<n>

Specify connection timeout in milliseconds (minimum: 1, default: 5000)

--torcontrol=<ip:port> Tor control port to use if onion listening enabled (default: 127.0.0.1:9051)
--torpassword=<pass> Tor control port password (default: empty)
--upnp

Use UPnP to map the listening port (default: 0)

--whitebind=<addr> Bind to given address and whitelist peers connecting to it. Use [host]:port notation for IPv6
--whitelist=<IP address or network> Whitelist peers connecting from the given IP address (e.g.
1.2.3.4) or CIDR notated network (e.g. 1.2.3.0/24). Can be specified multiple
times.
--whitelistrelay

Accept relayed transactions received from whitelisted peers even when not relaying transactions (default: 1)

--whitelistforcerelay Force relay of transactions from whitelisted peers even if they violate local relay
policy (default: 1)

8
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--maxuploadtarget=<n> Tries to keep outbound traffic under the given target (in MiB per 24h), 0 =
no limit (default: 0)
Wallet options
--disablewallet

Do not load the wallet and disable wallet RPC calls

--keypool=<n>

Set key pool size to <n> (default: 1000)

--fallbackfee=<amt> A fee rate (in HISTORIA/kB) that will be used when fee estimation has insufficient data (default: 0.00001)
--mintxfee=<amt>

Fees (in HISTORIA/kB) smaller than this are considered zero fee for transaction
creation (default: 0.00001)

--paytxfee=<amt>

Fee (in HISTORIA/kB) to add to transactions you send (default: 0.00)

--rescan

Rescan the block chain for missing wallet transactions on startup

--salvagewallet

Attempt to recover private keys from a corrupt wallet on startup

--spendzeroconfchange Spend unconfirmed change when sending transactions (default: 1)
--txconfirmtarget=<n> If paytxfee is not set, include enough fee so transactions begin confirmation
on average within n blocks (default: 6)
--usehd

Use hierarchical deterministic key generation (HD) after BIP39/BIP44. Only has
effect during wallet creation/first start (default: 0)

--mnemonic

User defined mnemonic for HD wallet (BIP39). Only has effect during wallet
creation/first start (default: randomly generated)

--mnemonicpassphrase User defined mnemonic passphrase for HD wallet (BIP39). Only has effect
during wallet creation/first start (default: empty string)
--hdseed

User defined seed for HD wallet (should be in hex). Only has effect during wallet
creation/first start (default: randomly generated)

--upgradewallet

Upgrade wallet to latest format on startup

--wallet=<file>

Specify wallet file (within data directory) (default: wallet.dat)

--walletbroadcast

Make the wallet broadcast transactions (default: 1)

--walletnotify=<cmd> Execute command when a wallet transaction changes (%s in cmd is replaced
by TxID)
--zapwallettxes=<mode> Delete all wallet transactions and only recover those parts of the blockchain
through -rescan on startup (1 = keep tx meta data e.g. account owner and payment
request information, 2 = drop tx meta data)
--createwalletbackups=<n> Number of automatic wallet backups (default: 10)
--walletbackupsdir=<dir> Specify full path to directory for automatic wallet backups (must exist)
--keepass

Use KeePass 2 integration using KeePassHttp plugin (default: 0)

--keepassport=<port> Connect to KeePassHttp on port <port> (default: 19455)
--keepasskey=<key> KeePassHttp key for AES encrypted communication with KeePass
--keepassid=<name> KeePassHttp id for the established association
--keepassname=<name> Name to construct url for KeePass entry that stores the wallet passphrase

1.3. Wallets
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ZeroMQ notification options
--zmqpubhashblock=<address> Enable publish hash block in <address>
--zmqpubhashtx=<address> Enable publish hash transaction in <address>
--zmqpubhashtxlock=<address> Enable publish hash transaction (locked via InstantSend) in <address>
--zmqpubhashgovernancevote=<address> Enable publish hash of governance votes in <address>
--zmqpubhashgovernanceobject=<address> Enable publish hash of governance objects (like proposals) in <address>
--zmqpubhashinstantsenddoublespend=<address> Enable publish transaction hashes of attempted
InstantSend double spend in <address>
--zmqpubrawblock=<address> Enable publish raw block in <address>
--zmqpubrawtx=<address> Enable publish raw transaction in <address>
--zmqpubrawtxlock=<address> Enable publish raw transaction (locked via InstantSend) in <address>
--zmqpubrawinstantsenddoublespend=<address> Enable publish raw transactions of attempted InstantSend double spend in <address>
Debugging/Testing options
--uacomment=<cmt> Append comment to the user agent string
--debug=<category> Output debugging information (default: 0, supplying <category> is optional).
If <category> is not supplied or if <category> = 1, output all debugging information.<category> can be: addrman, alert, bench, cmpctblock, coindb, db, http,
leveldb, libevent, lock, mempool, mempoolrej, net, proxy, prune, rand, reindex,
rpc, selectcoins, tor, zmq, historia (or specifically: gobject, instantsend, keepass,
masternode, mnpayments, mnsync, privatesend, spork).
--help-debug

Show all debugging options (usage: –help -help-debug)

--logips

Include IP addresses in debug output (default: 0)

--logtimestamps

Prepend debug output with timestamp (default: 1)

--minrelaytxfee=<amt> Fees (in HISTORIA/kB) smaller than this are considered zero fee for relaying, mining and transaction creation (default: 0.00001)
--maxtxfee=<amt>

Maximum total fees (in HISTORIA) to use in a single wallet transaction or raw
transaction; setting this too low may abort large transactions (default: 0.10)

--printtoconsole

Send trace/debug info to console instead of debug.log file

--printtodebuglog

Send trace/debug info to debug.log file (default: 1)

--shrinkdebugfile

Shrink debug.log file on client startup (default: 1 when no -debug)

Chain selection options

10

--testnet

Use the test chain

--devnet=<name>

Use devnet chain with provided name
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--litemode=<n>

Disable all Historia specific functionality (Masternodes, PrivateSend, InstantSend, Governance) (0-1, default: 0)

--sporkaddr=<hex> Override spork address. Only useful for regtest and devnet. Using this on mainnet
or testnet will ban you.
--minsporkkeys=<n> Overrides minimum spork signers to change spork value. Only useful for regtest
and devnet. Using this on mainnet or testnet will ban you.
Masternode options
--masternode=<n>

Enable the client to act as a masternode (0-1, default: 0)

--mnconf=<file>

Specify masternode configuration file (default: masternode.conf)

--mnconflock=<n>

Lock masternodes from masternode configuration file (default: 1)

--masternodeprivkey=<n> Set the masternode private key
--masternodecollater=<n> Set the collateral for masternode roles
PrivateSend options
--enableprivatesend=<n> Enable use of automated PrivateSend for funds stored in this wallet (0-1,
default: 0)
--privatesendmultisession=<n> Enable multiple PrivateSend mixing sessions per block, experimental
(0-1, default: 0)
--privatesendsessions=<n> Use N separate masternodes in parallel to mix funds (1-10, default: 4)
--privatesendrounds=<n> Use N separate masternodes for each denominated input to mix funds (216, default: 4)
--privatesendamount=<n> Keep N HISTORIA anonymized (2-21000000, default: 1000)
--liquidityprovider=<n> Provide liquidity to PrivateSend by infrequently mixing coins on a continual
basis (0-100, default: 0, 1=very frequent, high fees, 100=very infrequent, low
fees)
InstantSend options
--enableinstantsend=<n> Enable InstantSend, show confirmations for locked transactions (0-1, default: 1)
--instantsendnotify=<cmd> Execute command when a wallet InstantSend transaction is successfully
locked (%s in cmd is replaced by TxID)
Node relay options
--bytespersigop

Minimum bytes per sigop in transactions we relay and mine (default: 20)

--datacarrier

Relay and mine data carrier transactions (default: 1)

--datacarriersize

Maximum size of data in data carrier transactions we relay and mine (default: 83)

1.3. Wallets
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Block creation options
--blockmaxsize=<n> Set maximum block size in bytes (default: 2000000)
--blockprioritysize=<n> Set maximum size of high-priority/low-fee transactions in bytes (default:
10000)
--blockmintxfee=<amt> Set lowest fee rate (in HISTORIA/kB) for transactions to be included in
block creation. (default: 0.00001)
RPC server options
--server

Accept command line and JSON-RPC commands

--rest

Accept public REST requests (default: 0)

--rpcbind=<addr>

Bind to given address to listen for JSON-RPC connections. Use [host]:port notation for IPv6. This option can be specified multiple times (default: bind to all
interfaces)

--rpccookiefile=<loc> Location of the auth cookie (default: data dir)
--rpcuser=<user>

Username for JSON-RPC connections

--rpcpassword=<pw> Password for JSON-RPC connections
--rpcauth=<userpw> Username and hashed password for JSON-RPC connections. The field
<userpw> comes in the format: <USERNAME>:<SALT>$<HASH>. A canonical python script is included in share/rpcuser. The client then connects normally
using the rpcuser=<USERNAME>/rpcpassword=<PASSWORD> pair of arguments. This option can be specified multiple times
--rpcport=<port>

Listen for JSON-RPC connections on <port> (default: 9998 or testnet: 19998)

--rpcallowip=<ip>

Allow JSON-RPC connections from specified source. Valid for <ip> are a single IP (e.g. 1.2.3.4), a network/netmask (e.g. 1.2.3.4/255.255.255.0) or a network/CIDR (e.g. 1.2.3.4/24). This option can be specified multiple times

--rpcthreads=<n>

Set the number of threads to service RPC calls (default: 4)

historia-qt
Historia Core QT GUI, use same command line options as historiad with additional options for UI as described below.
Usage
historia-qt [command-line options] Start Historia Core QT GUI
Wallet options
--windowtitle=<name> Wallet window title

12
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Debugging/Testing options
--debug=<category> Output debugging information (default: 0, supplying <category> is optional).
If <category> is not supplied or if <category> = 1, output all debugging information.<category> can be: addrman, alert, bench, cmpctblock, coindb, db, http,
leveldb, libevent, lock, mempool, mempoolrej, net, proxy, prune, rand, reindex,
rpc, selectcoins, tor, zmq, historia (or specifically: gobject, instantsend, keepass,
masternode, mnpayments, mnsync, privatesend, spork), qt.
UI options
--choosedatadir

Choose data directory on startup (default: 0)

--lang=<lang>

Set language, for example “de_DE” (default: system locale)

--min

Start minimized

--rootcertificates=<file> Set SSL root certificates for payment request (default: -system-)
--splash

Show splash screen on startup (default: 1)

--resetguisettings

Reset all settings changed in the GUI

historia-cli
Historia Core RPC client
Usage
historia-cli [options] <command> [params] Send command to Historia Core
historia-cli [options] help List commands
historia-cli [options] help <command> Get help for a command
Options
--help

This help message

--conf=<file>

Specify configuration file (default: historia.conf)

--datadir=<dir>

Specify data directory

Chain selection options
--testnet

Use the test chain

--regtest

Enter regression test mode, which uses a special chain in which blocks can be
solved instantly. This is intended for regression testing tools and app development.

--named

Pass named instead of positional arguments (default: false)

--rpcconnect=<ip>

Send commands to node running on <ip> (default: 127.0.0.1)

1.3. Wallets
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--rpcport=<port>

Connect to JSON-RPC on <port> (default: 9998 or testnet: 19998)

--rpcwait

Wait for RPC server to start

--rpcuser=<user>

Username for JSON-RPC connections

--rpcpassword=<pw> Password for JSON-RPC connections
--rpcclienttimeout=<n> Timeout during HTTP requests (default: 900)
--stdin

Read extra arguments from standard input, one per line until EOF/Ctrl-D (recommended for sensitive information such as passphrases)

historia-tx
Historia Core historia-tx utility
Usage
historia-tx [options] <hex-tx> [commands] Update hex-encoded historia transaction
historia-tx [options] -create [commands] Create hex-encoded historia transaction
Options
--help

This help message

--create

Create new, empty TX.

--json

Select JSON output

--txid

Output only the hex-encoded transaction id of the resultant transaction.

Chain selection options
--testnet

Use the test chain

--regtest

Enter regression test mode, which uses a special chain in which blocks can be
solved instantly. This is intended for regression testing tools and app development.

Commands
delin=N Delete input N from TX
delout=N Delete output N from TX
in=TXID:VOUT Add input to TX
locktime=N Set TX lock time to N
nversion=N Set TX version to N
outaddr=VALUE:ADDRESS Add address-based output to TX
outpubkey=VALUE:PUBKEY[:FLAGS] Add pay-to-pubkey output to TX. Optionally add the “S” flag to wrap the
output in a pay-to-script-hash.
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outdata=[VALUE:]DATA Add data-based output to TX
outscript=VALUE:SCRIPT[:FLAGS] Add raw script output to TX. Optionally add the “S” flag to wrap the output
in a pay-to-script-hash.
outmultisig=VALUE:REQUIRED:PUBKEYS:PUBKEY1:PUBKEY2:. . . .[:FLAGS] Add Pay To n-of-m Multisig output to TX. n = REQUIRED, m = PUBKEYS. Optionally add the “S” flag to wrap the output in a pay-toscript-hash.
sign=SIGHASH-FLAGS Add zero or more signatures to transaction. This command requires JSON registers:prevtxs=JSON object, privatekeys=JSON object. See signrawtransaction docs for format of sighash flags,
JSON objects.
Register Commands
load=NAME:FILENAME Load JSON file FILENAME into register NAME
set=NAME:JSON-STRING Set register NAME to given JSON-STRING
RPC commands
This documentation lists all available RPC commands as of Historia version 0.16.3.0 and limited documentation on
what each command does. For full documentation of arguments, results and examples, type help ( “command” ) to
view full details at the console. You can enter commands either from Tools > Debug console in the QT wallet, or
using historia-cli for headless wallets and historiad.
Addressindex
getaddressbalance Returns the balance for an address(es) (requires addressindex to be enabled).
getaddressdeltas Returns all changes for an address (requires addressindex to be enabled).
getaddressmempool Returns all mempool deltas for an address (requires addressindex to be enabled).
getaddresstxids Returns the txids for an address(es) (requires addressindex to be enabled).
getaddressutxos Returns all unspent outputs for an address (requires addressindex to be enabled).
Blockchain
getbestblockhash Returns the hash of the best (tip) block in the longest blockchain.
getblock “blockhash” ( verbosity ) If verbosity is 0, returns a string that is serialized, hex-encoded data for block
‘hash’. If verbosity is 1, returns an Object with information about block <hash>. If verbosity is 2, returns an
Object with information about block <hash> and information about each transaction.
getblockchaininfo Returns an object containing various state info regarding blockchain processing.
getblockcount Returns the number of blocks in the longest blockchain.
getblockhash height Returns hash of block in best-block-chain at height provided.
getblockhashes timestamp Returns array of hashes of blocks within the timestamp range provided.
getblockheader “hash” ( verbose ) If verbose is false, returns a string that is serialized, hex-encoded data for blockheader ‘hash’. If verbose is true, returns an Object with information about blockheader <hash>.
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getblockheaders “hash” ( count verbose ) Returns an array of items with information about <count> blockheaders
starting from <hash>. If verbose is false, each item is a string that is serialized, hex-encoded data for a single
blockheader. If verbose is true, each item is an Object with information about a single blockheader.
getchaintips ( count branchlen ) Return information about all known tips in the block tree, including the main chain
as well as orphaned branches.
getdifficulty Returns the proof-of-work difficulty as a multiple of the minimum difficulty.
getmempoolinfo Returns details on the active state of the TX memory pool.
getrawmempool ( verbose ) Returns all transaction ids in memory pool as a json array of string transaction ids.
getspentinfo Returns the txid and index where an output is spent.
gettxout “txid” n ( include_mempool ) Returns details about an unspent transaction output.
gettxoutproof [“txid”,. . . ] ( blockhash ) Returns a hex-encoded proof that “txid” was included in a block.
gettxoutsetinfo Returns statistics about the unspent transaction output set. Note this call may take some time.
verifychain ( checklevel nblocks ) Verifies blockchain database.
verifytxoutproof “proof” Verifies that a proof points to a transaction in a block, returning the transaction it commits
to and throwing an RPC error if the block is not in our best chain.
Control

debug ( 0 | 1 | addrman | alert | bench | coindb | db | lock | rand | rpc | selectcoins | mempool | mempoolrej | net | proxy | prune | h
Change debug category on the fly. Specify single category or use ‘+’ to specify many.
getinfo DEPRECATED. Returns an object containing various state info.
getmemoryinfo Returns an object containing information about memory usage
help ( “command” ) (“subCommand”) List all commands, or get help for a specified comm
stop Stop Historia Core server.
Historia
getgovernanceinfo Returns an object containing governance parameters.
getpoolinfo Returns an object containing mixing pool related information.
getsuperblockbudget index Returns the absolute maximum sum of superblock payments allowed.
gobject “command”. . . Manage governance objects. Available commands:
check Validate governance object data (proposal only)
prepare Prepare governance object by signing and creating tx
submit Submit governance object to network
deserialize Deserialize governance object from hex string to JSON
count Count governance objects and votes (additional param: ‘json’ or ‘all’, default: ‘json’)
get Get governance object by hash
getvotes Get all votes for a governance object hash (including old votes)
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getcurrentvotes Get only current (tallying) votes for a governance object hash (does not include old
votes)
list List governance objects (can be filtered by signal and/or object type)
diff List differences since last diff
vote-alias Vote on a governance object by masternode alias (using masternode.conf setup)
vote-conf Vote on a governance object by masternode configured in historia.conf
vote-many Vote on a governance object by all masternodes (using masternode.conf setup)
masternode “command”. . . Set of commands to execute masternode related actions. Available commands:
check Force check all masternodes and remove invalid ones
count Get information about number of masternodes (DEPRECATED options: ‘total’, ‘ps’, ‘enabled’, ‘qualify’, ‘all’)
current Print info on current masternode winner to be paid the next block (calculated locally)
genkey Generate new masternodeprivkey, optional param: ‘compressed’ (boolean, optional, default=false) generate compressed privkey
outputs Print masternode compatible outputs
start-alias Start single remote masternode by assigned alias configured in masternode.conf
start-<mode> Start remote masternodes configured in masternode.conf (<mode>: ‘all’, ‘missing’,
‘disabled’)
status Print masternode status information
list Print list of all known masternodes (see masternodelist for more info)
list-conf Print masternode.conf in JSON format
winner Print info on next masternode winner to vote for
winners Print list of masternode winners
masternodebroadcast “command”. . . Set of commands to create and relay masternode broadcast messages. Available commands:
create-alias Create single remote masternode broadcast message by assigned alias configured in
masternode.conf
create-all Create remote masternode broadcast messages for all masternodes configured in masternode.conf
decode Decode masternode broadcast message
relay Relay masternode broadcast message to the network
masternode list ( “mode” “filter” ) Get a list of masternodes in different modes. This call is identical to masternodelist call.
mnsync [status | next | reset] Returns the sync status, updates to the next step or resets it entirely.
privatesend “command” Available commands:
start Start mixing
stop Stop mixing
reset Reset mixing
sentinelping version Sentinel ping.
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spork “command” Shows information about current state of sporks. Available commands:
show Show all current spork values
active Show which sporks are active
voteraw <masternode-tx-hash> <masternode-tx-index> <governance-hash> <vote-signal> [yes | no | abstain] <time> <vote-sig>
Compile and relay a governance vote with provided external signature instead of signing vote internally
Generating
generate nblocks ( maxtries ) Mine up to nblocks blocks immediately (before the RPC call returns)
Mining
getblocktemplate ( TemplateRequest ) If the request parameters include a ‘mode’ key, that is used to explicitly
select between the default ‘template’ request or a ‘proposal’. It returns data needed to construct a block to work
on.
getmininginfo Returns a json object containing mining-related information.
getnetworkhashps ( nblocks height ) Returns the estimated network hashes per second based on the last n blocks.
Pass in [blocks] to override # of blocks, -1 specifies since last difficulty change. Pass in [height] to estimate the
network speed at the time when a certain block was found.
prioritisetransaction <txid> <priority delta> <fee delta> Accepts the transaction into mined blocks at a higher (or
lower) priority
submitblock “hexdata” ( “jsonparametersobject” ) Attempts to submit new block to network. The ‘jsonparametersobject’ parameter is currently ignored. See https://en.bitcoin.it/wiki/BIP_0022 for full specification.
Network
addnode “node” “add | remove | onetry” Attempts add or remove a node from the addnode list. Or try a connection
to a node once.
clearbanned Clear all banned IPs.
disconnectnode “address” Immediately disconnects from the specified node.
getaddednodeinfo ( “node” ) Returns information about the given added node, or all added nodes (note that onetry
addnodes are not listed here)
getconnectioncount Returns the number of connections to other nodes.
getnettotals Returns information about network traffic, including bytes in, bytes out, and current time.
getnetworkinfo Returns an object containing various state info regarding P2P networking.
getpeerinfo Returns data about each connected network node as a json array of objects.
listbanned List all banned IPs/Subnets.
ping Requests that a ping be sent to all other nodes, to measure ping time. Results provided in getpeerinfo, pingtime
and pingwait fields are decimal seconds. Ping command is handled in queue with all other commands, so it
measures processing backlog, not just network ping.
setban “subnet” “add | remove” (bantime) (absolute) Attempts add or remove a IP/Subnet from the banned list.
setnetworkactive true | false Disable/enable all p2p network activity.
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Rawtransactions
createrawtransaction [{“txid”:”id”,”vout”:n},. . . ] {“address”:amount,”data”:”hex”,. . . } ( locktime ) Create a
transaction spending the given inputs and creating new outputs. Outputs can be addresses or data. Returns
hex-encoded raw transaction. Note that the transaction’s inputs are not signed, and it is not stored in the wallet
or transmitted to the network.
decoderawtransaction “hexstring” Return a JSON object representing the serialized, hex-encoded transaction.
decodescript “hexstring” Decode a hex-encoded script.
fundrawtransaction “hexstring” ( options ) Add inputs to a transaction until it has enough in value to meet its out
value. This will not modify existing inputs, and will add at most one change output to the outputs.
getrawtransaction “txid” ( verbose ) Return the raw transaction data. If verbose is ‘true’, returns an Object with
information about ‘txid’. If verbose is ‘false’ or omitted, returns a string that is serialized, hex-encoded data for
‘txid’.
sendrawtransaction “hexstring” ( allowhighfees instantsend bypasslimits) Submits raw transaction (serialized,
hex-encoded) to local node and network. Also see createrawtransaction and signrawtransaction calls.
signrawtransaction “hexstring” ( [{“txid”:”id”,”vout”:n,”scriptPubKey”:”hex”,”redeemScript”:”hex”},. . . ] [“privatekey1”,. . . ]
Sign inputs for raw transaction (serialized, hex-encoded). The second optional argument (may be null) is an
array of previous transaction outputs that this transaction depends on but may not yet be in the block chain. The
third optional argument (may be null) is an array of base58-encoded private keys that, if given, will be the only
keys used to sign the transaction.
Util
createmultisig nrequired [“key”,. . . ] Creates a multi-signature address with n signature of m keys required. It returns a json object with the address and redeemScript.
estimatefee nblocks Estimates the approximate fee per kilobyte needed for a transaction to begin confirmation within
nblocks blocks.
estimatepriority nblocks DEPRECATED. Estimates the approximate priority a zero-fee transaction needs to begin
confirmation within nblocks blocks.
estimatesmartfee nblocks WARNING: This interface is unstable and may disappear or change! Estimates the approximate fee per kilobyte needed for a transaction to begin confirmation within nblocks blocks if possible and
return the number of blocks for which the estimate is valid.
estimatesmartpriority nblocks DEPRECATED. WARNING: This interface is unstable and may disappear or
change! Estimates the approximate priority a zero-fee transaction needs to begin confirmation within nblocks
blocks if possible and return the number of blocks for which the estimate is valid.
signmessagewithprivkey “privkey” “message” Sign a message with the private key of an address
validateaddress “address” Return information about the given historia address.
verifymessage “address” “signature” “message” Verify a signed message
Wallet
abandontransaction “txid” Mark in-wallet transaction <txid> as abandoned. This will mark this transaction and all
its in-wallet descendants as abandoned which will allow for their inputs to be respent.
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addmultisigaddress nrequired [“key”,. . . ] ( “account” ) Add a nrequired-to-sign multisignature address to the wallet. Each key is a Historia address or hex-encoded public key. If ‘account’ is specified (DEPRECATED), assign
address to that account.
backupwallet “destination” Safely copies current wallet file to destination, which can be a directory or a path with
filename.
dumphdinfo Returns an object containing sensitive private info about this HD wallet.
dumpprivkey “address” Reveals the private key corresponding to ‘address’. Then the importprivkey can be used
with this output
dumpwallet “filename” Dumps all wallet keys in a human-readable format.
getaccount “address” DEPRECATED. Returns the account associated with the given address.
getaccountaddress “account” DEPRECATED. Returns the current Historia address for receiving payments to this
account.
getaddressesbyaccount “account” DEPRECATED. Returns the list of addresses for the given account.
getbalance ( “account” minconf addlocked include_watchonly ) If account is not specified, returns the server’s total available balance. If account is specified (DEPRECATED), returns the balance in the account. Note that the
account “” is not the same as leaving the parameter out. The server total may be different to the balance in the
default “” account.
getnewaddress ( “account” ) Returns a new Historia address for receiving payments. If ‘account’ is specified (DEPRECATED), it is added to the address book so payments received with the address will be credited to ‘account’.
getrawchangeaddress Returns a new Historia address, for receiving change. This is for use with raw transactions,
NOT normal use.
getreceivedbyaccount “account” ( minconf addlocked ) DEPRECATED. Returns the total amount received by addresses with <account> in transactions with specified minimum number of confirmations.
getreceivedbyaddress “address” ( minconf addlocked ) Returns the total amount received by the given address in
transactions with at least minconf confirmations.
getspecialtxes “blockhash” ( type count skip verbosity ) Returns an array of special transactions found in the specified block
gettransaction “txid” ( include_watchonly ) Get detailed information about in-wallet transaction <txid>
getunconfirmedbalance Returns the server’s total unconfirmed balance
getwalletinfo Returns an object containing various wallet state info.
importaddress “address” ( “label” rescan p2sh ) Adds a script (in hex) or address that can be watched as if it were
in your wallet but cannot be used to spend.
importelectrumwallet “filename” index Imports keys from an Electrum wallet export file (.csv or .json)
importmulti “requests” “options” Import addresses/scripts (with private or public keys, redeem script (P2SH)), rescanning all addresses in one-shot-only (rescan can be disabled via options).
importprivkey “historiaprivkey” ( “label” ) ( rescan ) Adds a private key (as returned by dumpprivkey) to your
wallet.
importpubkey “pubkey” ( “label” rescan ) Adds a public key (in hex) that can be watched as if it were in your
wallet but cannot be used to spend.
importwallet “filename” Imports keys from a wallet dump file (see dumpwallet).
instantsendtoaddress “address” amount ( “comment” “comment-to” subtractfeefromamount ) Send an amount
to a given address. The amount is a real and is rounded to the nearest 0.00000001
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keepass <genkey | init | setpassphrase> Keepass settings.
keypoolrefill ( newsize ) Fills the keypool. Requires wallet passphrase to be set with walletpassphrase call.
listaccounts ( minconf addlocked include_watchonly) DEPRECATED. Returns Object that has account names as
keys, account balances as values.
listaddressbalances ( minamount ) Lists addresses of this wallet and their balances
listaddressgroupings Lists groups of addresses which have had their common ownership made public by common
use as inputs or as the resulting change in past transactions
listlockunspent Returns list of temporarily unspendable outputs. See the lockunspent call to lock and unlock transactions for spending.
listreceivedbyaccount ( minconf addlocked include_empty include_watchonly) DEPRECATED. List incoming
payments grouped by account.
listreceivedbyaddress ( minconf addlocked include_empty include_watchonly) List incoming payments grouped
by receiving address.
listsinceblock ( “blockhash” target_confirmations include_watchonly) Get all transactions in blocks since block
[blockhash], or all transactions if omitted
listtransactions ( “account” count skip include_watchonly) Returns up to ‘count’ most recent transactions skipping the first ‘from’ transactions for account ‘account’.
listunspent ( minconf maxconf [“addresses”,. . . ] [include_unsafe] ) Returns array of unspent transaction outputs
with between minconf and maxconf (inclusive) confirmations. Optionally filter to only include txouts paid to
specified addresses.
lockunspent unlock ([{“txid”:”txid”,”vout”:n},. . . ]) Updates list of temporarily unspendable outputs. Temporarily
lock (unlock=false) or unlock (unlock=true) specified transaction outputs.
move “fromaccount” “toaccount” amount ( minconf “comment” ) DEPRECATED. Move a specified amount
from one account in your wallet to another.
removeprunedfunds “txid” Deletes the specified transaction from the wallet. Meant for use with pruned wallets and
as a companion to importprunedfunds. This will effect wallet balances.
sendfrom “fromaccount” “toaddress” amount ( minconf addlocked “comment” “comment_to” )
DEPRECATED (use sendtoaddress). Sent an amount from an account to a historia address.
wallet passphrase to be set with walletpassphrase call.

Requires

sendmany “fromaccount” {“address”:amount,. . . } ( minconf addlocked “comment” [“address”,. . . ] subtractfeefromamount use
Send multiple times. Amounts are double-precision floating point numbers. Requires wallet passphrase to be
set with walletpassphrase call.
sendtoaddress “address” amount ( “comment” “comment_to” subtractfeefromamount use_is use_ps ) Send an
amount to a given address.
setaccount “address” “account” DEPRECATED. Sets the account associated with the given address.
settxfee amount Set the transaction fee per kB. Overwrites the paytxfee parameter.
signmessage “address” “message” Sign a message with the private key of an address Requires wallet passphrase to
be set with walletpassphrase call.
walletlock Removes the wallet encryption key from memory, locking the wallet. After calling this method, you
will need to call walletpassphrase again before being able to call any methods which require the wallet to be
unlocked.
walletpassphrase “passphrase” timeout ( mixingonly ) Stores the wallet decryption key in memory for ‘timeout’
seconds. This is needed prior to performing transactions related to private keys such as sending historias

1.3. Wallets

21

Historia Documentation, Release latest

walletpassphrasechange “oldpassphrase” “newpassphrase” Changes the wallet passphrase from ‘oldpassphrase’
to ‘newpassphrase’.

1.4 Governance
Coming soon

1.5 Voting Nodes
Historia is the first cryptocurrency with a focus on a voting platform and file storage mechanism (IPFS) paired together
to attempt to give an accurate consensus-based view of future history. These features are implemented on top of a
network of masternodes and the IPFS network, which gives rise to many exciting features not available on conventional
blockchains.
This documentation focuses on understanding the setup on a voting node to the network.
Option 1: Self-operated voting node
Users that would like to setup a voting node should learn about how the voting system works, and to learn to setup a
voting node from the Historia wallet. Several steps are required, and the user must assume responsibility for setting
up, securing and maintaining both the collateral. See these pages for information on how to set up a voting node.

1.5.1 Understanding Voting Nodes
Voting Node Requirements
• 100 HTA: A voting masternode requires 100 HTA. This role gives voting rights to the wallet owner. Historia
can be obtained from exchanges such as Stex.
• A voting node does not require to run 24 hours a day and do not require a public IP address, but to help the
network it’s recommended to run your voting node 24 hours a day.
Benefits of Voting Node
Voting nodes are needed to vote on the records and proposals for network governance. Users should following these
directions if they would like to participate in the creation and maintainence of the Historia network.

1.5.2 Setup a Voting Node
Setting up a voting node requires a basic understanding of how to use a computer, as well as an ability to follow
instructions closely.
Before you begin
This guide assumes you are setting up a voting node for the first time. You will need:
• 100 HTA.
• A little extra HTA for registration transactions: 1-5 HTA
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• Historia Core Wallet v0.17.0.2 or later to store your Historia. You can get this here https://github.com/
HistoriaOffical/historia/releases/
• A computer running Windows, MacOS, or Linux.
In this guide, we will assume you will be working from a Windows computer. However, alternative steps for using
MacOS or Linux will be indicated where necessary.
Voting Node Requirements

The Historia developers have tried to make this process as simple as possible for the users. The following requirements are requ
• Voting Node
– Collateral Requirement: 100 HTA
– A little extra HTA for registration transactions: 1-5 HTA
– Internet access on home network.
– A computer running Windows or Linux. MacOS coming soon.
In this guide, we will setup a Voting Node with collateral of 100. If you are looking to setup a Content Distribution
Masternode with collateral of 5000 please see the appropriate guide for that.
Setup a Voting Node
Before you begin, please have the required HTA in your wallet. After you have the required HTA in your wallet you
can begin to setup a Voting Node. This guide will describe the steps for Historia Core. Note MacOS currently has a
bug that prevents a user from setting up a Voting Node. We are working on it.
Option 1: Automated Voting Node Setup
Open Historia Core wallet and wait for it to synchronize with the network. It should look like this when ready:
Your wallet shold already it has more than 100 HTA in it.
Click Tools > Setup Voting Node to open the Setup Voting Node tab. It should take about 1 hour to setup your Voting
Node. Please do not close or switch this tabs until after you completed the process. Otherwise you may have to restart
this process. It should look like this when ready:
Once you are ready to being click on the “Generate Voting Node Keys” button. This is generate all the required keys
for you.
After your keys are generated, it is recommended to store these in notepad until the voting node has been registered
and you have completed this process. Make special note of the BLS Secret Key. This is be require to finalize your
Voting Node setup below.
Next click the Send Collateral TX button. This is automatically send the required collateral transaction to setup your
Voting Node. This is send exactly 100 HTA to your own wallet. You will only lose a small amount in transaction fees.
Once the collateral transaction has been processed you will have the collateral hash with index at the end of it. Copy
this value to notepad.
Once the transaction is complete, view the transaction in a blockchain explorer by searching for the collateral transaction hash. For best results, please wait for 6 confirmations before the proceeding.
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Fig. 1: Fully synchronized Historia Core wallet

Fig. 2: Voting Node Setup Tab in Historia Core wallet
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Fig. 3: Click Generate Voting Node Keys button

Fig. 4: Click Generate Voting Node Keys button
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Fig. 5: Click Send Collateral TX button

Fig. 6: Collateral Hash
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After 6 confirmations, please add a unique Identity that your Voting Node will be known by. It should be noted that
this will also be your name on the future web application and currently you are not be allowed to change it. Changing
your Identity might come in a future release but is currently not supported. It also must not be a duplicate name
already in use. The wallet will automatically check for a valid name. You can use any of the following characters in
your Identity:
-abcdefghijklmnopqrstuvwxyzABCDEFGHIJKLMNOPQRSTUVWXYZ0123456789

After you enter a valid name, the Register Voting Node button will become active.

Fig. 7: Valid Identity and the Register Button is now active
Click the Register Voting Node button to register your node. This is send a special transaction to register your node.
You will only lose a small amount in transaction fees.
After you click the Register Voting Node button, and 1 block is mined your wallet will show a “Registered” status for
your Voting Node.
To finalize your registration and to allow for in wallet voting you must create or edit your historia.conf file. You can
click on the Open Config button to edit this file. Note this requires a association with a file type. Linux and MacOS
should have this default. Windows will require you to open this file manually.
Open notepad (or nano on Linux / MacOS) and open or create a new file named historia.conf Add the following lines
into your historia.conf file:
#---masternode=1
masternodecollateral=100
masternodeblsprivkey=<BLS Secret Key that you recorded from above>
#----

Save this file in the historiacore data folder on the PC running the Historia Core wallet using the filename historia.conf.
You may need to enable View hidden items to view this folder. Be sure to select All files if using Notepad so you don’t
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Fig. 8: Registrated Status
end up with a .conf.txt file extension by mistake. For different operating systems, the Historiacore folder can be found
in the following locations (copy and paste the shortcut text into the Save dialog to find it quickly):
Platform
Linux
OSX
Windows

Path

Shortcut

/home/yourusername/.historiacore
/Macintosh
HD/Library/Application
Support/HistoriaCore
C:UsersyourusernameAppDataRoamingHistoria Core

~/.historiacore
~/Library/Application
port/HistoriaCore
%APPDATA%Historia Core

Sup-

Close Historia Core and restart the Historia Core application and let it finish syncing. After your wallet has synced
click Tools > Setup Voting Node to open the Setup Voting Node tab.
If everything has gone correctly, the result should look something like this:
There is no need to have your wallet open 24 hours a day. You can open and close your wallet at will.
Encrypt And Backup Your Wallet
The first step is to secure your wallet (if you have not already done so). First, encrypt the wallet by selecting Settings
> Encrypt wallet. You should use a strong, new password that you have never used somewhere else. Take note of
your password and store it somewhere safe or you will be permanently locked out of your wallet and lose access to
your funds. Next, back up your wallet file by selecting File > Backup Wallet. Save the file to a secure location
physically separate to your computer, since this will be the only way you can access our funds if anything happens to
your computer.
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Fig. 9: Your Voting Node is now setup correctly

1.6 Masternodes
Historia is the first cryptocurrency with a focus on a voting platform and file storage mechanism (IPFS) paired together
to attempt to give an accurate consensus-based view of future history. These features are implemented on top of a
network of masternodes and the IPFS network, which gives rise to many exciting features not available on conventional
blockchains.
Historia also makes use of the first role based masternode system to allow for different roles and different rewards
depending on the service the masternode provides to the Historia network.
This documentation focuses on understanding the services masternodes provide to the network, while also including
guides on how to run a masternode and IPFS by leveraging either a hosting provider or by setting up and maintaining
your own hosting solution. The primary requirement to run a masternode on the Historia network is 5000 HTA. This is
known as the collateral, and cannot be spent without interrupting operation of the masternode. The second requirement
is the actual server running the Historia masternode software and the IPFS daemon.
Option 1: Self-operated masternode
Users with a deeper understanding (or curiosity) about the inner workings of the Historia network may choose to operate their own masternode on their own host server. Several steps are required, and the user must assume responsibility
for setting up, securing and maintaining both the server and collateral. See these pages for information on how to set
up a self-operated masternode.

1.6.1 Understanding Masternodes
Coming soon.
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Masternode requirements
• 5000 Historia: An IPFS masternode requires 5000 HTA. Historia can be obtained from exchanges such as Stex.
This role gives voting rights to the masternode owner and receives a 32% reward, increasing every 2 months
until 50% reward is reached. IPFS daemon is required to provide for content distribution.
• A server or VPS running Linux: Most recent guides use Ubuntu 18.04 LTS. We recommend VPS services such
as Vultr and DigitalOcean, although any decent provider will do. Generally, an instance with low to average
specifications will do, although performance requirements will increase according to this roadmap.
• A dedicated IPv4: These usually come with the VPS/server.
• A little time and (heart): Masternodes used to require complex setup, but tools such as historiaman now greatly
simplify the process.
In addition to the 5000 HTA held in collateral, masternodes also have minimum hardware requirements. As of version
v0.17.0.2, these requirements are as follows:

CPU
RAM
Disk
Network

Minimum
1x 1 GHz
2 GB
20 GB
400 GB/mth

Recommended
1x 2 GHz
4 GB
40 GB
1 TB/mth

Masternode bandwidth use ranges between 30-100 GB per month and will grow as the network does.

1.6.2 Hosting Services
Coming soon.

1.6.3 Setup For Linux
Setting up a masternode requires a basic understanding of Linux and blockchain technology, as well as an ability to
follow instructions closely. It also requires regular maintenance and careful security. There are some decisions to be
made along the way, and optional extra steps to take for increased security.
Before you begin
This guide assumes you are setting up a single masternode for the first time. You will need:
• 5000 HTA.
• A wallet to store your Historia, currently only Historia Core wallet is supported.
• A Linux server, preferably a Virtual Private Server (VPS).
• IPv4 address
• Your own DNS name
We also assume you will be working from a Windows computer. However, since most of the work is done on your
Linux VPS, alternative steps for using macOS or Linux will be indicated where necessary.
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Masternode Info
• Collateral Requirement: 5000 HTA
• Reward: 32% per block - increaes 2.5% every 2 months until 50% per block
• Ports: TCP 10101, TCP 4001, TCP 443, TCP 80
• IPFS Required: Yes
• IPv4 address required
• DNS name
In this guide, we will setup a Content Distribution Masternode (CDMN) with collateral of 5000.
Set up your VPS
A VPS, more commonly known as a cloud server, is fully functional installation of an operating system (usually
Linux) operating within a virtual machine. The virtual machine allows the VPS provider to run multiple systems on
one physical server, making it more efficient and much cheaper than having a single operating system running on the
“bare metal” of each server. A VPS is ideal for hosting a Historia masternode because they typically offer guaranteed
uptime, redundancy in the case of hardware failure and a static IP address that is required to ensure you remain in the
masternode payment queue. While running a masternode from home on a desktop computer is technically possible, it
will most likely not work reliably because most ISPs allocate dynamic IP addresses to home users.
We will use Vultr hosting as an example of a VPS. First create an account and add credit. Then go to the Servers menu
item on the left and click + to add a new server.
Select a location for your new server on the following screen:

Fig. 10: Vultr server location selection screen
Select Ubuntu 18.04 x64 as the server type. We use this LTS release of Ubuntu instead of the latest version because
LTS releases are supported with security updates for 5 years, instead of the usual 9 months.
Select a server size offering at least 2GB of memory.
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Fig. 11: Vultr server type selection screen

Fig. 12: Vultr server size selection screen
Enter a hostname and label for your server. In this example we will use htamn01 as the hostname.

Fig. 13: Vultr server hostname & label selection screen
Add IPv6 for your server. IPv6 isn’t required but nice to have.
Vultr will now install your server. This process may take a few minutes.
Click Manage when installation is complete and take note of the IPv4 address, username and password.
Set up your operating system
We will begin by connecting to your newly provisioned server. On Windows, we will first download an app called
PuTTY to connect to the server. Go to the PuTTY download page and select the appropriate MSI installer for your
system. On Mac or Linux you can ssh directly from the terminal - simply type ssh root@<server_ip> and enter
your password when prompted.
Double-click the downloaded file to install PuTTY, then run the app from your Start menu. Enter the IP address of the
server in the Host Name field and click Open. You may see a certificate warning, since this is the first time you are
connecting to this server. You can safely click Yes to trust this server in the future.
You are now connected to your server and should see a terminal window. Begin by logging in to your server with the
user root and password supplied by your hosting provider.
You should immediately change the root password and store it in a safe place for security. You can copy and paste
any of the following commands by selecting them in your browser, pressing Ctrl + C, then switching to the PuTTY
window and right-clicking in the window. The text will paste at the current cursor location:
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Fig. 14: Vultr IPv6 Address screen

Fig. 15: Vultr server installation screen

Fig. 16: Vultr server management screen

Fig. 17: PuTTY download page
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Fig. 18: PuTTY security alert when connecting to a new server

Fig. 19: Password challenge when connecting to your VPS for the first time
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passwd root

Enter and confirm a new password (preferably long and randomly generated). Next we will create a new user with the
following command, replacing <username> with a username of your choice:
adduser <username>

You will be prompted for a password. Enter and confirm using a new password (different to your root password) and
store it in a safe place. You will also see prompts for user information, but this can be left blank. Once the user has
been created, we will add them to the sudo group so they can perform commands as root:
usermod -aG sudo <username>

Now, while still as root, we will update the system from the Ubuntu package repository:
apt update
apt upgrade

The system will show a list of upgradable packages. Press Y and Enter to install the packages. We will now install a
firewall (and some other packages we will use later), add swap memory and reboot the server to apply any necessary
kernel updates, and then login to our newly secured environment as the new user:
apt install ufw python virtualenv git unzip pv

(press Y and Enter to confirm)
ufw
ufw
ufw
ufw
ufw
ufw
ufw
ufw

allow ssh/tcp
limit ssh/tcp
allow 10101/tcp
allow 443/tcp
allow 80/tcp
allow 4001/tcp
logging on
enable

(press Y and Enter to confirm)
fallocate -l 4G /swapfile
chmod 600 /swapfile
mkswap /swapfile
swapon /swapfile
nano /etc/fstab

Add the following line at the end of the file (press tab to separate each word/number), then press Ctrl + X to close the
editor, then Y and Enter save the file.
/swapfile none swap sw 0 0

Finally, in order to prevent brute force password hacking attacks, we will install fail2ban and disable root login over
ssh. These steps are optional, but highly recommended. Start with fail2ban:
apt install fail2ban

Create a new configuration file:
nano /etc/fail2ban/jail.local
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And paste in the following configuration:
[sshd]
enabled = true
port = 22
filter = sshd
logpath = /var/log/auth.log
maxretry = 3

Then press Ctrl + X to close the editor, then Y and Enter save the file. Retart and enable the fail2ban service:
systemctl restart fail2ban
systemctl enable fail2ban

Next, open the SSH configuration file to disable root login over SSH:
nano /etc/ssh/sshd_config

Locate the line that reads PermitRootLogin yes and set it to PermitRootLogin no. Directly below this,
add a line which reads AllowUsers <username>, replacing <username> with the username you selected
above. Then press Ctrl + X to close the editor, then Y and Enter save the file.
Then reboot the server:
reboot now

PuTTY will disconnect when the server reboots.
While this setup includes basic steps to protect your server against attacks, much more can be done. However, since
the masternode does not actually store the keys to any Historia, these steps are considered beyond the scope of this
guide.
Setup Domain Name System (DNS) A Record
Historia requires a DNS name set to enabled SSL for your IPFS node that will be setup below. This is beyond the
scope of this document, but there is plenty of documentation online on how to do this. Find a cheap DNS registrar and
create a A record that points to the IP address of your VPS. Namecheap.com or GoDaddy.com are options for this.
This can be any top level domain, such as .xyz ($0.88 annually) or .fun ($1.00 annually), so get this cheapest domain
you can get.
Remember that if you live in a oppressive country, your name will be associated with your DNS record in the global
WHOIS database. Some DNS providers such as ionos.com will give a DNS name privacy for free with domain
registration. But they would still be required to hand over your domain name information via court order. Another
option is using one of the new blockchain DNS systems such as unstoppabledomains.com, and using crypto currency
to purchase your domain name. However we have not tested using a blockchain DNS system yet.
Send the collateral
A Historia address with a single unspent transaction output (UTXO) of exactly 5000 HTA is required to operate a
Voting Masternode. Once it has been sent, various keys regarding the transaction must be extracted for later entry in
a configuration file. A masternode can be started from the official Historia Core wallet. This guide will describe the
steps for Historia Core.
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Option 1: Sending from Historia Core wallet
Open Historia Core wallet and wait for it to synchronize with the network. It should look like this when ready:

Fig. 20: Fully synchronized Historia Core wallet
Click Tools > Debug console to open the console. Type the following two commands into the console to generate a
new Historia address for the collateral:
getnewaddress
HBm4FXgZXdb4NYqx1DJ3h9v9reFqYe9F6L

Take note of the masternode private key and collateral address, since we will need it later. The next step is to secure
your wallet (if you have not already done so). First, encrypt the wallet by selecting Settings > Encrypt wallet. You
should use a strong, new password that you have never used somewhere else. Take note of your password and store
it somewhere safe or you will be permanently locked out of your wallet and lose access to your funds. Next, back
up your wallet file by selecting File > Backup Wallet. Save the file to a secure location physically separate to your
computer, since this will be the only way you can access our funds if anything happens to your computer.
Content Distribution Masternode (CDMN) - Collateral 5000
If setting up a Content Distribution Masternode (CDMN), send exactly 5000 HTA in a single transaction to the new
address you generated in the previous step. This may be sent from another wallet, or from funds already held in your
current wallet.
Check Transaction
Once the transaction is complete, view the transaction in a blockchain explorer by searching for the address. You
will need 15 confirmations before you can start the masternode, but you can continue with the next step at this point
already: installing Historia Core on your VPS.
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Install Historia Core
You MUST use Historia v0.17.0.1 or later, otherwise this process will fail. https://github.com/HistoriaOffical/historia/
releases/
Historia Core is the software behind both the Historia Core GUI wallet and Historia masternodes. If not displaying a
GUI, it runs as a daemon on your VPS (historiad), controlled by a simple command interface (historia-cli).
Open PuTTY or a console again and connect using the username and password you just created for your new, non-root
user.
Option 1: Manual installation
To manually download and install the components of your Historia masternode, visit https://github.com/
HistoriaOffical/historia/releases/ on your computer to find the link to the latest Historia Core wallet. Right-click
on Download TGZ for Historia Core Linux 64 Bit and select Copy link address. Go back to your terminal window and
enter the following command, pasting in the address to the latest version of Historia Core by right clicking or pressing
Ctrl + V:
cd /tmp
wget https://github.com/HistoriaOffical/historia/releases/download/0.17.0.1/
˓→historiacore-0.17.0.1-x86_64-linux-gnu.tar.gz

Create a working directory for Historia, extract the compressed archive and copy the necessary files to the directory:
mkdir ~/.historiacore
tar xfvz historiacore-0.17.0.1-x86_64-linux-gnu.tar.gz
cp historiacore-0.17.0/bin/historiad ~/.historiacore/
cp historiacore-0.17.0/bin/historia-cli ~/.historiacore/
chmod 777 ~/.historiacore/historia*

Clean up unneeded files:
rm historiacore-0.17.0.1-x86_64-linux-gnu.tar.gz
rm -r historiacore-0.17.0/

Create a configuration file using the following command:
nano ~/.historiacore/historia.conf

An editor window will appear. We now need to create a configuration file specifying several variables. Copy and paste
the following text to get started, then replace the variables specific to your configuration as follows:
#---rpcuser=XXXXXXXXXXXXX
rpcpassword=XXXXXXXXXXXXXXXXXXXXXXXXXXXX
rpcallowip=127.0.0.1
#---listen=1
server=1
daemon=1
#---#masternode=1
#masternodeblsprivkey=
#masternodecollateral=5000
externalip=XXX.XXX.XXX.XXX:10101
#----
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Replace the fields marked with XXXXXXX as follows:
• rpcuser: enter any string of numbers or letters, no special characters allowed
• rpcpassword: enter any string of numbers or letters, no special characters allowed
• externalip: this is the IPv4 address of your VPS
Leave the masternode and masternodeblsprivkey fields commented out for now. The result should look something like
this:

Fig. 21: Entering key data in historia.conf on the masternode
Press Ctrl + X to close the editor and Y and Enter save the file.
Start Historiad Masternode
You can now start running Historia on the masternode to begin synchronization with the blockchain:
~/.historiacore/historiad

You will see a message reading Historia Core server starting. We will now install Sentinel, a piece of software
which operates as a watchdog to communicate to the network that your node is working properly:
cd ~/.historiacore
git clone https://github.com/HistoriaOffical/sentinel.git
cd sentinel
virtualenv venv
venv/bin/pip install -r requirements.txt
venv/bin/python bin/sentinel.py

You will see a message reading historiad not synced with network! Awaiting full sync before running Sentinel.
Add historiad and sentinel to crontab to make sure it runs every minute to check on your masternode:
crontab -e

Choose nano as your editor and enter the following lines at the end of the file:
* * * * * cd ~/.historiacore/sentinel && ./venv/bin/python bin/sentinel.py 2>&1 >>
˓→sentinel-cron.log
* * * * * pidof historiad || ~/.historiacore/historiad
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Press enter to make sure there is a blank line at the end of the file, then press Ctrl + X to close the editor and Y and
Enter save the file. We now need to wait for 15 confirmations of the collateral transaction to complete, and wait for
the blockchain to finish synchronizing on the masternode. You can use the following commands to monitor progress:
~/.historiacore/historia-cli mnsync status

When synchronisation is complete, you should see the following response:
{
"AssetID": 999,
"AssetName": "MASTERNODE_SYNC_FINISHED",
"Attempt": 0,
"IsBlockchainSynced": true,
"IsMasternodeListSynced": true,
"IsWinnersListSynced": true,
"IsSynced": true,
"IsFailed": false
}

Continue with the next step to install IPFS required by your masternode. Running the IPFS daemon is now a required
part of the masternode system. You must follow these steps.
Setup IPFS
Download / Install IPFS Daemon
To run the IPFS Daemon you must install the Go Lang:
sudo apt-get update
sudo apt-get install golang-go -y

Next download and install IPFS daemon. Because we have used Ubuntu 18.04 64-bit for our OS, there isn’t a deb
package for this version of Ubuntu:
wget https://dist.ipfs.io/go-ipfs/v0.4.23/go-ipfs_v0.4.23_linux-amd64.tar.gz
tar xvfz go-ipfs_v0.4.23_linux-amd64.tar.gz
sudo mv go-ipfs/ipfs /usr/local/bin/ipfs

Clean up:
rm -rf go-ipfs/

Initialize IPFS Daemon for Historia
Since we will be using IPFS only for Historia, we can safely run the initialization:
ipfs init -p server

Remove Original Bootstap IPFS Nodes and Connect to Historia IPFS Swarm
Add Historia IPFS bootstrap nodes, configure our IPFS node, and only connect to the Historia IPFS Swarm:
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ipfs bootstrap add /ip4/202.182.119.4/tcp/4001/ipfs/
˓→QmVjkn7yEqb3LTLCpnndHgzczPAPAxxpJ25mNwuuaBtFJD
ipfs bootstrap add /ip4/149.28.22.65/tcp/4001/ipfs/
˓→QmZkRv4qfXvtHot37STR8rJxKg5cDKFnkF5EMh2oP6iBVU
ipfs bootstrap add /ip4/149.28.247.81/tcp/4001/ipfs/
˓→QmcvrQ8LpuMqtjktwXRb7Mm6JMCqVdGz6K7VyQynvWRopH
ipfs bootstrap add /ip4/45.32.194.49/tcp/4001/ipfs/
˓→QmZXbb5gRMrpBVe79d8hxPjMFJYDDo9kxFZvdb7b2UYamj
ipfs bootstrap add /ip4/45.76.236.45/tcp/4001/ipfs/
˓→QmeW8VxxZjhZnjvZmyBqk7TkRxrRgm6aJ1r7JQ51ownAwy
ipfs bootstrap add /ip4/209.250.233.69/tcp/4001/ipfs/
˓→Qma946d7VCm8v2ny5S2wE7sMFKg9ZqBXkkZbZVVxjJViyu
ipfs config --json Datastore.StorageMax '"50GB"'
ipfs config --json Gateway.HTTPHeaders.Access-Control-Allow-Headers '["X-Requested˓→With", "Access-Control-Expose-Headers", "Range", "Authorization"]'
ipfs config --json Gateway.HTTPHeaders.Access-Control-Allow-Methods '["POST", "GET"]'
ipfs config --json Gateway.HTTPHeaders.Access-Control-Allow-Origin '["*"]'
ipfs config --json Gateway.HTTPHeaders.Access-Control-Expose-Headers '["Location",
˓→"Ipfs-Hash"]'
ipfs config --json Gateway.HTTPHeaders.X-Special-Header '["Access-Control-Expose˓→Headers: Ipfs-Hash"]'
ipfs config --json Gateway.NoFetch 'false'
ipfs config --json Swarm.ConnMgr.HighWater '500'
ipfs config --json Swarm.ConnMgr.LowWater '200'

Now when you start IPFS, the IPFS daemon will now connect to the Historia IPFS swarm when started.
Create IPFS Service To Restart on Reboot or Crash
Next, create a service for IPFS to restart on reboot or crash. Create a new service file:
sudo nano

/etc/systemd/system/ipfs.service

Copy and past the below config and save the ipfs.service file. Add the username that Historia runs under to “User=”.
Most likely this is the user that you have created when setting up the OS.
[Unit]
Description=ipfs.service
After=network.target
[Service]
Type=simple
Restart=always
RestartSec=1
StartLimitInterval=0
User=<YOURUSERNAME>
ExecStart=/usr/local/bin/ipfs daemon
[Install]
WantedBy=multi-user.target

Start IPFS Daemon for Historia
Start the IPFS service:
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systemctl start ipfs

Enable the IPFS service to start on reboot:
systemctl enable ipfs

Check the IPFS service is running:
systemctl status ipfs

Get IPFS Peer ID
Historia needs the IPFS ID generated by the IPFS initialization command in masternode registration command below.
Run this command and save the ID value for later:
ipfs id

Result:
{

**"ID": "QmVjkn7yEqb3LTLCpnndHgzczPAPAxxpJ25mNwuuaBtFJD",** // THIS IS YOUR IPFS
PEER ID, HISTORIA WILL NEED THIS
"PublicKey":
˓→"CAASpgIwggEiMA0GCSqGSIb3DQEBAQUAA4IBDwAwggEKAoIBAQDGKc55NxrimIWjWIFK6J9Kgj0caCwzGbNCZ4xphSww4j3gsP
˓→ZhODyv+wwuQs92FJ2Lb6n/HB/
˓→fqsjvkPYQeSNe+T1Djjc2OYzuZkTZwCNrY9hGUEbEq6O1DeqMHWRN1Gy0fu31QyL6mjVq804udm0sQlO3Cey8hmChTBH+GCw1sT
˓→qGfHRO1bA/trYLTsjIEMLI+xi/HtVzrOg6n+/kQopjWLCGy19IXn/ZVzOZuJhpqBYAkVnUd1b9na5ND/
˓→3iN5VTdO6biK+NQ8hH/DEi4sb8wMqpAgMBAAE=",
"Addresses": [
"/ip4/127.0.0.1/tcp/4001/ipfs/QmVjkn7yEqb3LTLCpnndHgzczPAPAxxpJ25mNwuuaBtFJD",
"/ip4/<youripv4address>/tcp/4001/ipfs/
˓→QmVjkn7yEqb3LTLCpnndHgzczPAPAxxpJ25mNwuuaBtFJD",
],
"AgentVersion": "go-ipfs/0.4.21/8ca278f45",
"ProtocolVersion": "ipfs/0.1.0"
}
˓→

Check IPFS is connected to Historia Swarm
To verify that IPFS is connect to the correct swarm:
ipfs swarm peers

Output:
/ip4/149.28.22.65/tcp/4001/ipfs/QmZkRv4qfXvtHot37STR8rJxKg5cDKFnkF5EMh2oP6iBVU
/ip4/149.28.247.81/tcp/4001/ipfs/QmcvrQ8LpuMqtjktwXRb7Mm6JMCqVdGz6K7VyQynvWRopH
/ip4/202.182.119.4/tcp/4001/ipfs/QmVjkn7yEqb3LTLCpnndHgzczPAPAxxpJ25mNwuuaBtFJD
/ip4/45.32.194.49/tcp/4001/ipfs/QmZXbb5gRMrpBVe79d8hxPjMFJYDDo9kxFZvdb7b2UYamj
/ip4/45.76.236.45/tcp/4001/ipfs/QmeW8VxxZjhZnjvZmyBqk7TkRxrRgm6aJ1r7JQ51ownAwy

You will see at least these peers and many more.
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Nginx Web Proxy
After setting up IPFS, Nginx proxy and a DNS entry is needed to be setup:
sudo apt-get install nginx

Go to the ip address of your VPS in a web browser to verify that Nginix is running.
Install SSL Certificate
In this example we will be using the free SSL certificate service Let’s Encrypt to create and install our SSL certificate.
First we must install the Let’s Encrypt Certbot. Note YOU MUST keep TCP 80 open to get and maintain a valid SSL
certificate:
sudo add-apt-repository ppa:certbot/certbot
sudo apt-get update
sudo apt-get -y install python-certbot-nginx

Next we need to prepare Nginx configuration file for Let’s Encrypt Certbot. If you’re using the default configuration
file /etc/nginx/sites-available/default open it with a text editor such as nano and find the server_name directive. Replace
the underscore, _, with your own domain name(s):
sudo nano /etc/nginx/sites-available/default

After editing the configuration file, the server_name directive should look as follows. In this example, we assume that
your domain is example.com and that you’re requesting a certificate for example.com. Make sure to use your own
domain name here:
server_name example.com;

Save the file and restart Nginx:
systemctl restart nginx

The following command will obtain a certificate for you. Edit your Nginx configuration to use it, and reload Nginx.:
sudo certbot --nginx -d example.com

If Certbot can obtain an SSL certificate, it will ask how you would like to configure your HTTPS settings. Please
choose option 2 to redirect who visit your IPFS node over an unsecured connection.:
Please choose whether or not to redirect HTTP traffic to HTTPS, removing HTTP access.
------------------------------------------------------------------------------1: No redirect - Make no further changes to the webserver configuration.
2: Redirect - Make all requests redirect to secure HTTPS access. Choose this for
new sites, or if you're confident your site works on HTTPS. You can undo this
change by editing your web server's configuration.
------------------------------------------------------------------------------Select the appropriate number [1-2] then [enter] (press 'c' to cancel):

If the setup process has gone correctly, you can now go to your domain name in a browser and it will be protected by
an SSL certification. However we are not done yet.
Lets finish this process and setup Nginix to point to the IPFS daemon that is running on your masternode. If you’re
using the default configuration file /etc/nginx/sites-available/default open it with a text editor such as nano again.:
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sudo nano /etc/nginx/sites-available/default

Change your nginx configuration file to look something like this:
server {
root /var/www/html;
server_name example.com; #Your domain name should already be set here
#BEGIN IPFS SETTINGS#
location / {
proxy_pass http://127.0.0.1:8080;
proxy_set_header Host $host;
proxy_cache_bypass $http_upgrade;
proxy_set_header X-Forwarded-For $remote_addr;
allow all;
}
#END IPFS SETTINGS#
listen [::]:443 ssl ipv6only=on; # managed by Certbot
listen 443 ssl; # managed by Certbot
ssl_certificate /etc/letsencrypt/live/example.com/fullchain.pem; # managed by Certbot
ssl_certificate_key /etc/letsencrypt/live/example.com/privkey.pem; # managed by
˓→Certbot
include /etc/letsencrypt/options-ssl-nginx.conf; # managed by Certbot
ssl_dhparam /etc/letsencrypt/ssl-dhparams.pem; # managed by Certbot
}
server {
if ($host = exmaple.com) {
return 301 https://$host$request_uri;
} # managed by Certbot
listen 80 default_server;
listen [::]:80 default_server;
server_name example.com;
return 404; # managed by Certbot

Save the file and restart Nginx:
systemctl restart nginx

Congratulations! You now have finished setup for IPFS. You can now test out the IPFS Nginx proxy combination by
opening the following in your browser:
https://<yourdomainname>/ipfs/QmS4ustL54uo8FzR9455qaxZwuMiUhyvMcX9Ba8nUH4uVv/readme

If you see the IPFS help message, you have successful setup your IPFS Nginx proxy. You can now proceed to installing
your Historia masternode.
Continue with the next step to construct the ProTx transaction required to enable your masternode.
Register your masternode
DIP003 introduced several changes to how a masternode is set up and operated. These changes and the three keys
required for the different masternode roles are described briefly under dip3-changes in this documentation.
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Option 1: Registering from Historia Core wallet
Identify the funding transaction
If you used an address in Historia Core wallet for your collateral transaction, you now need to find the txid of the
transaction. Click Tools > Debug console and enter the following command:
masternode outputs

This should return a string of characters similar to the following:
{
"16347a28f4e5edf39f4dceac60e2327931a25fdee1fb4b94b63eeacf0d5879e3" : "1",
}

The first long string is your collateralHash, while the last number is the collateralIndex.
Generate a BLS key pair
A public/private BLS key pair is required to operate a masternode. The private key is specified on the masternode
itself, and allows it to be included in the deterministic masternode list once a provider registration transaction with the
corresponding public key has been created.
If you are using a hosting service, they may provide you with their public key, and you can skip this step. If you
are hosting your own masternode or have agreed to provide your host with the BLS private key, generate a BLS
public/private keypair in Historia Core by clicking Tools > Debug console and entering the following command:
bls generate
{
"secret": "395555d67d884364f9e37e7e1b29536519b74af2e5ff7b62122e62c2fffab35e",
"public":
˓→"99f20ed1538e28259ff80044982372519a2e6e4cdedb01c96f8f22e755b2b3124fbeebdf6de3587189cf44b3c6e7670e
˓→"
}

These keys are NOT stored by the wallet and must be kept secure, similar to the value provided in the past by
the masternode genkey command.
Add the private key to your masternode configuration
The public key will be used in following steps. The private key must be entered in the historia.conf file on the
masternode. This allows the masternode to watch the blockchain for relevant Pro*Tx transactions, and will cause it to
start serving as a masternode when the signed ProRegTx is broadcast by the owner (final step below). Log in to your
masternode using ssh or PuTTY and edit the configuration file as follows:
nano ~/.historiacore/historia.conf

The editor appears with the existing masternode configuration. Add or uncomment these lines in the file, replacing the
key with your BLS private key generated above:
masternode=1
masternodecollateral=5000
masternodeblsprivkey=395555d67d884364f9e37e7e1b29536519b74af2e5ff7b62122e62c2fffab35e
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Press enter to make sure there is a blank line at the end of the file, then press Ctrl + X to close the editor and Y
and Enter save the file. We now need to restart the masternode for this change to take effect. Enter the following
commands, waiting a few seconds in between to give Historia Core time to shut down:
~/.historiacore/historia-cli stop
sleep 15
~/.historiacore/historiad

We will now prepare the transaction used to register the masternode on the network.
Prepare a ProRegTx transaction
A pair of BLS keys for the operator were already generated above, and the private key was entered on the masternode.
The public key is used in this transaction as the operatorPubKey.
First, we need to get a new, unused address from the wallet to serve as the owner key address (ownerKeyAddr).
This is not the same as the collateral address holding 5000 Historia. Generate a new address as follows:
getnewaddress
HTGfMbCy2X65th3L78JVyqpzhu6p1fbSC6

This address can also be used as the voting key address (votingKeyAddr). Alternatively, you can specify an
address provided to you by your chosen voting delegate, or simply generate a new voting key address as follows:
getnewaddress
HDsy8GUnsdFKWrRHB8WbD4oaLvETDZ9scY

Then either generate or choose an existing address to receive the owner’s masternode payouts (payoutAddress).
It is also possible to use an address external to the wallet:
getnewaddress
HEAjS5DJ9cjprZvk3t1eeq7jn2dhZztfDJ

You can also optionally generate and fund another address as the transaction fee source (feeSourceAddress).
If you selected an external payout address, you must specify a fee source address. Either the payout address or
fee source address must have enough balance to pay the transaction fee, so send a few coins here, or the final
register_submit transaction will fail.:
getnewaddress
HQyqm7srzV7nYhGLjuzTzjBs452suStCQW

The private keys to the owner and fee source addresses must exist in the wallet submitting the transaction to the
network. If your wallet is protected by a password, it must now be unlocked to perform the following commands.
Unlock your wallet for 5 minutes:
walletpassphrase yourSecretPassword 300

We will now prepare an unsigned ProRegTx special transaction using the protx register_prepare command.
This command has the following syntax:
protx register_prepare collateralHash collateralIndex ipAndPort ownerKeyAddr
operatorPubKey votingKeyAddr operatorReward payoutAddress ipfsPeerId identity
˓→(feeSourceAddress)
(continues on next page)
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(continued from previous page)

Open a text editor such as notepad to prepare this command. Replace each argument to the command as follows:
• collateralHash: The txid of the 5000 Historia collateral funding transaction
• collateralIndex: The output index of the 5000 Historia funding transaction
• ipAndPort: Masternode IP address and port, in the format x.x.x.x:yyyy
• ownerKeyAddr: The new Historia address generated above for the owner/voting address
• operatorPubKey: The BLS public key generated above (or provided by your hosting service)
• votingKeyAddr: The new Historia address generated above, or the address of a delegate, used for proposal
voting
• operatorReward: The percentage of the block reward allocated to the operator as payment
• payoutAddress: A new or existing Historia address to receive the owner’s masternode rewards
• ipfsPeerId: The public IPFS ID of your IPFS daemon required from the above IPFS setup.
• identity: This is the domain name that you previously have registered and tested above https:
//<yourdomainname>/ipfs/QmS4ustL54uo8FzR9455qaxZwuMiUhyvMcX9Ba8nUH4uVv/readme
• feeSourceAddress: An (optional) address used to fund ProTx fee. payoutAddress will be used if not
specified.
Example (remove line breaks if copying):
protx register_prepare
16347a28f4e5edf39f4dceac60e2327931a25fdee1fb4b94b63eeacf0d5879e3
1
45.76.230.239:19999
HTGfMbCy2X65th3L78JVyqpzhu6p1fbSC6
˓→

99f20ed1538e28259ff80044982372519a2e6e4cdedb01c96f8f22e755b2b3124fbeebdf6de3587189cf44b3c6e7670e
HDsy8GUnsdFKWrRHB8WbD4oaLvETDZ9scY
0
HEAjS5DJ9cjprZvk3t1eeq7jn2dhZztfDJ
QmVjkn7yEqb3LTLCpnndHgzczPAPAxxpJ25mNwuuaBtFJD
masternode1.historia.network
HQyqm7srzV7nYhGLjuzTzjBs452suStCQW

Output:
{

"tx":
"030001000175c9d23c2710798ef0788e6a4d609460586a20e91a15f2097f56fc6e007c4f8e0000000000feffffff01a194
˓→",
"collateralAddress": "HBm4FXgZXdb4NYqx1DJ3h9v9reFqYe9F6L",
"signMessage":
˓→"HEAjS5DJ9cjprZvk3t1eeq7jn2dhZztfDJ|0|HTGfMbCy2X65th3L78JVyqpzhu6p1fbSC6|HDsy8GUnsdFKWrRHB8WbD4oaLv
˓→"
}
˓→

Next we will use the collateralAddress and signMessage fields to sign the transaction, and the output of
the tx field to submit the transaction.
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Sign the ProRegTx transaction
We will now sign the content of the signMessage field using the private key for the collateral address as specified
in collateralAddress. Note that no internet connection is required for this step, meaning that the wallet can
remain disconnected from the internet in cold storage to sign the message. In this example we will again use Historia
Core, but it is equally possible to use the signing function of a hardware wallet. The command takes the following
syntax:
signmessage collateralAddress signMessage

Example:

signmessage HBm4FXgZXdb4NYqx1DJ3h9v9reFqYe9F6L
˓→"HEAjS5DJ9cjprZvk3t1eeq7jn2dhZztfDJ|0|HTGfMbCy2X65th3L78JVyqpzhu6p1fbSC6|HDsy8GUnsdFKWrRHB8WbD4oaLv
˓→"

Output:
II8JvEBMj6I3Ws8wqxh0bXVds6Ny+7h5HAQhqmd5r/
˓→0lWBCpsxMJHJT3KBcZ23oUZtsa6gjgISf+a8GzJg1BfEg=

Submit the signed message
We will now submit the ProRegTx special transaction to the blockchain to register the masternode. This command must be sent from a Historia Core wallet holding a balance on either the feeSourceAddress or
payoutAddress, since a standard transaction fee is involved. The command takes the following syntax:
protx register_submit tx sig

Where:
• tx:
The serialized transaction previously returned in the tx output field from the protx
register_prepare command
• sig: The message signed with the collateral key from the signmessage command
Example:

protx register_submit
˓→030001000175c9d23c2710798ef0788e6a4d609460586a20e91a15f2097f56fc6e007c4f8e0000000000feffffff01a1949
˓→II8JvEBMj6I3Ws8wqxh0bXVds6Ny+7h5HAQhqmd5r/
˓→0lWBCpsxMJHJT3KBcZ23oUZtsa6gjgISf+a8GzJg1BfEg=

Output:
aba8c22f8992d78fd4ff0c94cb19a5c30e62e7587ee43d5285296a4e6e5af062

Your masternode is now registered and will appear on the Deterministic Masternode List after the transaction is mined
to a block. You can view this list on the Masternodes -> DIP3 Masternodes tab of the Historia Core wallet, or in
the console using the command protx list valid, where the txid of the final protx register_submit
transaction identifies your masternode.
For support please come ask questions on the support channel in the Historia Discord.
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1.6.4 Setup For Windows
Setting up a masternode requires a basic understanding of Windows and blockchain technology, as well as an ability
to follow instructions closely. It also requires regular maintenance and careful security. There are some decisions to
be made along the way, and optional extra steps to take for increased security.
Before you begin
This guide assumes you are setting up a single masternode for the first time. You will need:
• 5000 HTA
• A wallet to store your Historia, currently only Historia Core wallet is supported
• A Windows 10 or Windows Server instance. [Can be a PC or VPS]
• Static IPv4 address
• Your own DNS name
If you are setting up from your own home network, ports need to be publicly open on the Internet. This normally
requires Port Forwarding on your router, which is out of scope for this document. Use your favorite search engine to
research Port Forwarding.
Masternode Info
• Collateral Requirement: 5000 HTA
• Reward: 32% per block - increaes 2.5% every 2 months until 50% per block
• Ports: TCP 10101, TCP 4001, TCP 443, TCP 80 (Home network would require port forwarding)
• IIS or any SSL supported Webserver
• IPFS Required: Yes
• Static IPv4 address required
• Your own DNS name
In this guide, we will setup a Content Distribution Masternode (CDMN) with collateral of 5000.
Set up your VPS
If you are setting this up on your home network you can skip this step
A VPS, more commonly known as a cloud server, is fully functional installation of an operating system operating
within a virtual machine. The virtual machine allows the VPS provider to run multiple systems on one physical server,
making it more efficient and much cheaper than having a single operating system running on the “bare metal” of each
server. A VPS is ideal for hosting a Historia masternode because they typically offer guaranteed uptime, redundancy
in the case of hardware failure and a static IP address that is required to ensure you remain in the masternode payment
queue. While running a masternode from home on a desktop computer is technically possible, it will most likely
not work reliably because most ISPs allocate dynamic IP addresses to home users. We will use Vultr hosting as an
example of a VPS. First create an account and add credit. Then go to the Servers menu item on the left and click + to
add a new server.
Select a location for your new server on the following screen.
Select Windows as the server type.
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Select a server size offering at least 2GB of memory.

Enter a hostname and label for your server. In this example we will use htamn01 as the hostname.

Add IPv6 for your server. IPv6 isn’t required but nice to have.

Vultr will now install your server. This process may take a few minutes.
Click Manage when installation is complete and take note of the IPv4 address, username and password.
Setup Firewall
To make communication possible you need to allow following TCP ports through your firewall. If you are setting
this up on your home network you must also setup port forwarding for the required ports
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Setup Domain Name System (DNS) A Record
Historia requires a DNS name set to enabled SSL for your IPFS node that will be setup below. This is beyond the
scope of this document, but there is plenty of documentation online on how to do this. Find a cheap DNS registrar
and create a A record that points to the IP address of your VPS. Namecheap.com or GoDaddy.com are options for
this. This can be any top level domain, such as .xyz ($0.88 annually) or .fun ($1.00 annually), so get this cheapest
domain you can get. Remember that if you live in a oppressive country, your name will be associated with your DNS
record in the global WHOIS database. Some DNS providers such as ionos.com will give a DNS name privacy for free
with domain registration. But they would still be required to hand over your domain name information via court order.
Another option is using one of the new blockchain DNS systems such as unstoppabledomains.com and using crypto
currency to purchase your domain name. However we have not tested using a blockchain DNS system yet.
Option 1: A Record – NS Zone

Option 2: Child Name – Domain Panel
Install Historia Windows Wallet
You MUST use Historia 0.17.0.2 or later, otherwise this process will fail. https://github.com/HistoriaOffical/historia/
releases/
Download the correct Windows Historia setup file from the previous URL. Once downloaded, run the Historia installer
and install the Historia wallet. Open the wallet and let the blockchain sync completely.
Send the collateral
A Historia address with a single unspent transaction output (UTXO) of exactly 5000 HTA is required to operate a
Voting Masternode. Once it has been sent, various keys regarding the transaction must be extracted for later entry in
a configuration file. A masternode can be started from the official Historia Core wallet. This guide will describe the
steps for Historia Core.
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Option 1: Sending from Historia Core wallet
Open Historia Core wallet and wait for it to synchronize with the network. It should look like this when ready:
Click Tools > Debug console to open the console. Type the following two commands into the console to generate a
new Historia address for the collateral:
getnewaddress
HBvcjyzWmt9x9QJNVDyxezhxSXcWEDEdsS

Take note of the masternode private key and collateral address, since we will need it later. The next step is to secure
your wallet (if you have not already done so). First, encrypt the wallet by selecting Settings > Encrypt wallet. You
should use a strong, new password that you have never used somewhere else. Take note of your password and store
it somewhere safe or you will be permanently locked out of your wallet and lose access to your funds. Next, back
up your wallet file by selecting File > Backup Wallet. Save the file to a secure location physically separate to your
computer, since this will be the only way you can access our funds if anything happens to your computer.
Content Distribution Masternode (CDMN) - Collateral 5000
If setting up a Content Distribution Masternode (CDMN), send exactly 5000 HTA in a single transaction to the new
address you generated in the previous step. This may be sent from another wallet, or from funds already held in your
current wallet.
Check Transaction
Once the transaction is complete, view the transaction in a blockchain explorer by searching for the address. You
will need 15 confirmations before you can start the masternode, but you can continue with the next step at this point
already: installing Historia Core on your VPS.
Next, setup the historia.conf files by selecting Tools > Open Wallet Configuration File.
A text editor window will appear. We now need to create a configuration file specifying several variables. Copy and
paste the following text into the Wallet Configuration file, then replace the variables specific to your configuration as
follows:
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Fig. 22: Fully synchronized Historia Core wallet
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#---rpcuser=XXXXXXXXXXXXX
rpcpassword=XXXXXXXXXXXXXXXXXXXXXXXXXXXX
rpcallowip=127.0.0.1
#---listen=1
server=1
daemon=1
#---#masternode=1
#masternodeblsprivkey=
#masternodecollateral=5000
externalip=XXX.XXX.XXX.XXX:10101
#----

Replace the fields marked with XXXXXXX as follows:
• rpcuser: enter any string of numbers or letters, no special characters allowed
• rpcpassword: enter any string of numbers or letters, no special characters allowed
• masternodecollateral: 100 or 5000 depending on if you are setting up a Voting Masternode or Content
Distribution Masternode. For this guide set this to 5000.
• externalip: this is the IPv4 address of your VPS
Save the historia.conf file in the default location and exit the text editor.:
C:\Users\<yourusername>\AppData\Roaming\HistoriaCore\

Setup IPFS
Option 1: Use prebuild package
Download and follow instruction from this page:
https://dist.ipfs.io/#go-ipfs

Option 2: Compile from source
If want to build from source on Windows take a look at this document for instructions.:
https://github.com/ipfs/go-ipfs/blob/master/docs/windows.md
/ Note : To run the IPFS Daemon you must install the Go Lang

Option 3: Manual from compiled or downloaded files
Download or compile IPFS files and put them to a folder , then Ensure the Go and IPFS binaries (found in C:\Go\bin
or where you installed) are in your Path system environment variables. To check click System, Advanced system
settings, Environment Variables. . . and open Path under System variables:
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Initialize IPFS Daemon for Historia
Since we will be using IPFS only for Historia, we can safely run the initialization: (Run commands on Windows
Powershell or Command Prompt as Admin)
ipfs init

Remove Original Bootstap IPFS Nodes and Connect to Historia IPFS Swarm
Add Historia IPFS bootstrap nodes, configure our IPFS node, and only connect to the Historia IPFS Swarm.
ipfs bootstrap add /ip4/202.182.119.4/tcp/4001/ipfs/
˓→QmVjkn7yEqb3LTLCpnndHgzczPAPAxxpJ25mNwuuaBtFJD
ipfs bootstrap add /ip4/149.28.22.65/tcp/4001/ipfs/
˓→QmZkRv4qfXvtHot37STR8rJxKg5cDKFnkF5EMh2oP6iBVU
ipfs bootstrap add /ip4/149.28.247.81/tcp/4001/ipfs/
˓→QmcvrQ8LpuMqtjktwXRb7Mm6JMCqVdGz6K7VyQynvWRopH
ipfs bootstrap add /ip4/45.32.194.49/tcp/4001/ipfs/
˓→QmZXbb5gRMrpBVe79d8hxPjMFJYDDo9kxFZvdb7b2UYamj
ipfs bootstrap add /ip4/45.76.236.45/tcp/4001/ipfs/
˓→QmeW8VxxZjhZnjvZmyBqk7TkRxrRgm6aJ1r7JQ51ownAwy
ipfs bootstrap add /ip4/209.250.233.69/tcp/4001/ipfs/
˓→Qma946d7VCm8v2ny5S2wE7sMFKg9ZqBXkkZbZVVxjJViyu

If the commands did not work you have to do these manually by edit config file at
C:\Users\<YOURUSERNAME>.ipfs\config and add or edit parameters. Change your ipfs configuration file to
look something like this. It should be noted that this is not the entire IPFS file, but the areas that need to be changed:
...snipped...
"StorageMax": "50GB"
},
"Discovery": {
"MDNS": {
"Enabled": false,
"Interval": 10
}
},
"Experimental": {
"FilestoreEnabled": false,
"Libp2pStreamMounting": false,
"P2pHttpProxy": false,
"PreferTLS": false,
"QUIC": false,
"ShardingEnabled": false,
"UrlstoreEnabled": false
},
"Gateway": {
"APICommands": [],
"HTTPHeaders": {
"Access-Control-Allow-Headers": [
"X-Requested-With",
"Access-Control-Expose-Headers",
"Range",
"Authorization"
],
(continues on next page)
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(continued from previous page)

"Access-Control-Allow-Methods": [
"POST",
"GET"
],
"Access-Control-Allow-Origin": [
"*"
],
"Access-Control-Expose-Headers": [
"Location",
"Ipfs-Hash"
],
"X-Special-Header": [
"Access-Control-Expose-Headers: Ipfs-Hash"
]
},
"NoFetch": false,
"PathPrefixes": [],
"RootRedirect": "",
"Writable": false
...snipped...

Now when you start IPFS, the IPFS daemon will now connect to the Historia IPFS swarm when started.
ipfs daemon

Get IPFS Peer ID
Historia needs the IPFS ID generated by the IPFS initialization command in masternode registration command below.
Run this command and save the ID value for later:
ipfs id

Result :

{
**"ID": "QmVjkn7yEqb3LTLCpnndHgzczPAPAxxpJ25mNwuuaBtFJD",** // THIS IS YOUR IPFS PEER
˓→ID, HISTORIA WILL NEED THIS
"PublicKey":
˓→"CAASpgIwggEiMA0GCSqGSIb3DQEBAQUAA4IBDwAwggEKAoIBAQDGKc55NxrimIWjWIFK6J9Kgj0caCwzGbNCZ4xphSww4j3gsP
˓→ZhODyv+wwuQs92FJ2Lb6n/HB/
˓→fqsjvkPYQeSNe+T1Djjc2OYzuZkTZwCNrY9hGUEbEq6O1DeqMHWRN1Gy0fu31QyL6mjVq804udm0sQlO3Cey8hmChTBH+GCw1sT
˓→qGfHRO1bA/trYLTsjIEMLI+xi/HtVzrOg6n+/kQopjWLCGy19IXn/ZVzOZuJhpqBYAkVnUd1b9na5ND/
˓→3iN5VTdO6biK+NQ8hH/DEi4sb8wMqpAgMBAAE=",
"Addresses": [
"/ip4/127.0.0.1/tcp/4001/ipfs/QmVjkn7yEqb3LTLCpnndHgzczPAPAxxpJ25mNwuuaBtFJD",
"/ip4/<youripv4address>/tcp/4001/ipfs/
˓→QmVjkn7yEqb3LTLCpnndHgzczPAPAxxpJ25mNwuuaBtFJD",
],
"AgentVersion": "go-ipfs/0.4.21/8ca278f45",
"ProtocolVersion": "ipfs/0.1.0"
}
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Check IPFS is connected to Historia Swarm
To verify that IPFS is connect to the correct swarm:
ipfs swarm peers

Output
/ip4/149.28.22.65/tcp/4001/ipfs/QmZkRv4qfXvtHot37STR8rJxKg5cDKFnkF5EMh2oP6iBVU
/ip4/149.28.247.81/tcp/4001/ipfs/QmcvrQ8LpuMqtjktwXRb7Mm6JMCqVdGz6K7VyQynvWRopH
/ip4/202.182.119.4/tcp/4001/ipfs/QmVjkn7yEqb3LTLCpnndHgzczPAPAxxpJ25mNwuuaBtFJD
/ip4/45.32.194.49/tcp/4001/ipfs/QmZXbb5gRMrpBVe79d8hxPjMFJYDDo9kxFZvdb7b2UYamj
/ip4/45.76.236.45/tcp/4001/ipfs/QmeW8VxxZjhZnjvZmyBqk7TkRxrRgm6aJ1r7JQ51ownAwy

You MUST see at least these peers to verify you are connected to the Historia IPFS swarm. If you do not see these
peers, you will not receive any extra rewards, so please go back, re-read the IPFS documentation and get connected to
the proper swarm.
Setup IIS in Windows, SSL Certificate, and point to IPFS
Because this is a content distribution masternode, you must setup IIS web server with a valid SSL certificate in a
reverse proxy setup to properly point to IPFS. If IIS is not setup properly you will not receive the extra masternode
rewards.
Install IIS
First step in this process is to install IIS. Instead of walking through that process here, we will point you to this 10 step
installation procedure: https://teckangaroo.com/enable-iis-windows-10/
Create Binding in IIS
To properly setup the SSL certificate you must create a binding in IIS for your DNS A record that should already be
setup and pointed at your public IP address at this point. We are assuming you are using the “Default Web Site” for
this example.
• Open Run Command using the shortcut Win Key + R.
• Type in ‘inetmgr’.
• Select and run the Internet Information Services (IIS) Manager.
• Expand the left pane and select the “Default Web Site”.
• On the right pane, under Edit Site, click on “Bindings”.
• After the Site Bindings dialog box opens, click the “Add” button.
• Leave everything default and add your DNS A record name in the Host Name box. An example would be
testwinmn.historia.network
• Click Ok, then click close.
• On left hand pane, under the Manage Website section, click Restart
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Setup SSL Certificate for IIS
To setup the SSL certicate we are going to be using a free utility called Win-Acme, https://www.win-acme.com/ which
uses the Let’s Encrypt SSL certificate authority to issue a valid SSL certificate for free.
• Goto https://www.win-acme.com/, and download the latest version
• Extract the zip file into your C:\Program Files\ into a new folder called Win-acme
• Find the wacs.exe file in the new folder and right click on the file and select “Run as Administrator”.
• Win-acme will start
• Choose: N: Create new certificate (simple for IIS)
• Choose: 1: Default Web Site (1 binding)
• Choose: 3: Pick all bindings
• Choose: Continue with this selection? (y*/n) - yes
If all goes well you will have a new SSL certificate installed in IIS for your Default Site. If the Create certicate failed,
check the following things:
• Is Your firewall is blocking port 80 and port 443?
Setup Reverse Proxy from IIS to IPFS
Depending on your setup, you may need to install additional Microsoft IIS modules
• Confirm it’s installed or install the Windows URL rewrite module. It can be downloaded from https://www.iis.
net/downloads/microsoft/url-rewrite
• Confirm it’s installed or install Application Request Routing (ARR). It can be downloaded from https://www.
iis.net/downloads/microsoft/application-request-routing
• Open Run Command using the shortcut Win Key + R.
• Type in ‘inetmgr’.
• Select and run the Internet Information Services (IIS) Manager.
• Expand the left pane and select the “Default Web Site”.
• In the main pane in the middle, select the URL Rewrite module.
• After the URL Rewrite module has opened, on the left hand pane, select “Add Rule(s)”. . .
• After the “Add Rule(s)” dialog box opens, click on the “Reverse Proxy” and click OK.
• In the “Enter the server name of the IP address where the HTTP requests will be forwarded:” box, point to your
IPFS server: 127.0.0.1:8080
• Leave all other options default values.
• Click Ok
• On the left pane and select the “Default Web Site”, again.
• On right pane, under Manage Website, select Restart.
Congratulations! You now have finished setup for IPFS. You can now test out the IPFS Nginx proxy combination by
opening the following in your browser:
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https://<yourdomainname>/ipfs/QmS4ustL54uo8FzR9455qaxZwuMiUhyvMcX9Ba8nUH4uVv/readme

If you see the IPFS help message, you have successful setup your IPFS server with IIS in a reverse proxy configuration
with a valid SSL certifcate. If you do not see the IPFS help message, you must go back over all steps and get this
properly working before you can continue to setup your Historia masternode.
If everything is good, you can now proceed to installing your Historia masternode. Continue with the next step to
construct the ProTx transaction required to enable your masternode.
Register your masternode
Identify the funding transaction
If you used an address in Historia Core wallet for your collateral transaction, you now need to find the txid of the
transaction. Click Tools > Debug console and enter the following command:
masternode outputs

This should return a string of characters similar to the following:
{
"16347a28f4e5edf39f4dceac60e2327931a25fdee1fb4b94b63eeacf0d5879e3" : "1",
}

The first long string is your collateralHash, while the last number is the collateralIndex.
Generate a BLS key pair
A public/private BLS key pair is required to operate a masternode. The private key is specified on the masternode
itself, and allows it to be included in the deterministic masternode list once a provider registration transaction with the
corresponding public key has been created. If you are using a hosting service, they may provide you with their public
key, and you can skip this step. If you are hosting your own masternode or have agreed to provide your host with
the BLS private key, generate a BLS public/private keypair in Historia Core by clicking Tools > Debug console and
entering the following command:
bls generate
{
"secret": "395555d67d884364f9e37e7e1b29536519b74af2e5ff7b62122e62c2fffab35e",
"public":
˓→"99f20ed1538e28259ff80044982372519a2e6e4cdedb01c96f8f22e755b2b3124fbeebdf6de3587189cf44b3c6e7670e
˓→"
}

These keys are NOT stored by the wallet and must be kept secure, similar to the value provided in the past by
the masternode genkey command.
Add the private key to your masternode configuration
The public key will be used in following steps. The private key must be entered in the historia.conf file on the
masternode. This allows the masternode to watch the blockchain for relevant Pro*Tx transactions, and will cause it
to start serving as a masternode when the signed ProRegTx is broadcast by the owner (final step below). Edit the
configuration file:
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C:\Users\<yourusername>\AppData\Roaming\HistoriaCore\historia.conf

The editor appears with the existing masternode configuration. Add or uncomment these lines in the file, replacing the
key with your BLS private key generated above:
masternode=1
masternodecollateral=5000
masternodeblsprivkey=395555d67d884364f9e37e7e1b29536519b74af2e5ff7b62122e62c2fffab35e

Press enter to make sure there is a blank line at the end of the file, then save and close the editor. We now need to
restart the Historia Core for this change to take effect. Close Historia Core and run it again.
We will now prepare the transaction used to register the masternode on the network.
Prepare a ProRegTx transaction
A pair of BLS keys for the operator were already generated above, and the private key was entered on the masternode.
The public key is used in this transaction as the operatorPubKey. First, we need to get a new, unused address from
the wallet to serve as the owner key address (ownerKeyAddr). This is not the same as the collateral address holding
5000 Historia. Generate a new address in Historia Core by clicking Tools > Debug console and entering the following
command:
getnewaddress
HTGfMbCy2X65th3L78JVyqpzhu6p1fbSC6

Next generate your a voting key address (votingKeyAddr). Simply generate a new voting key address as follows:
getnewaddress
HDsy8GUnsdFKWrRHB8WbD4oaLvETDZ9scY

Then generate owner’s masternode payouts (payoutAddress). It is also possible to use an address external to the
wallet:
getnewaddress
HEAjS5DJ9cjprZvk3t1eeq7jn2dhZztfDJ

Then generate transaction fee source (feeSourceAddress). Then fee source address must have enough balance to
pay the transaction fee, so send a few coins here, or the final register_submit transaction will fail.:
getnewaddress
HQyqm7srzV7nYhGLjuzTzjBs452suStCQW

The private keys to the owner and fee source addresses must exist in the wallet submitting the transaction to the
network. If your wallet is protected by a password, it must now be unlocked to perform the following commands.
Unlock your wallet for 5 minutes:
walletpassphrase yourSecretPassword 300

Send some coins to your transaction fee source (feeSourceAddress).
sendtoaddress HQyqm7srzV7nYhGLjuzTzjBs452suStCQW 2
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We will now prepare an unsigned ProRegTx special transaction using the protx register_prepare command. This
command has the following syntax:
protx register_prepare collateralHash collateralIndex ipAndPort ownerKeyAddr
operatorPubKey votingKeyAddr operatorReward payoutAddress ipfsPeerId identity
˓→(feeSourceAddress)

Open a text editor such as notepad to prepare this command. Replace each argument to the command as follows:
• collateralHash: The txid of the 5000 Historia collateral funding transaction
• collateralIndex: The output index of the 5000 Historia funding transaction
• ipAndPort: Masternode IP address and port, in the format x.x.x.x:yyyy
• ownerKeyAddr: The new Historia address generated above for the owner/voting address
• operatorPubKey: The BLS public key generated above (or provided by your hosting service)
• votingKeyAddr: The new Historia address generated above, or the address of a delegate, used for proposal
voting
• operatorReward: The percentage of the block reward allocated to the operator as payment
• payoutAddress: A new or existing Historia address to receive the owner’s masternode rewards
• ipfsPeerId: The public IPFS ID of your IPFS daemon required from the above IPFS setup.
• identity: This is the domain name that you previously have registered and tested above https:
//<yourdomainname>/ipfs/QmS4ustL54uo8FzR9455qaxZwuMiUhyvMcX9Ba8nUH4uVv/readme
• feeSourceAddress: An (optional) address used to fund ProTx fee. payoutAddress will be used if not
specified.
Example (remove line breaks if copying):
protx register_prepare
16347a28f4e5edf39f4dceac60e2327931a25fdee1fb4b94b63eeacf0d5879e3
1
45.76.230.239:19999
HTGfMbCy2X65th3L78JVyqpzhu6p1fbSC6
99f20ed1538e28259ff80044982372519a2e6e4cdedb01c96f8f22e755b2b3124fbeebdf6de3587189cf44b3c6e7670e
HDsy8GUnsdFKWrRHB8WbD4oaLvETDZ9scY
0
HEAjS5DJ9cjprZvk3t1eeq7jn2dhZztfDJ
QmVjkn7yEqb3LTLCpnndHgzczPAPAxxpJ25mNwuuaBtFJD
masternode1.historia.network
HQyqm7srzV7nYhGLjuzTzjBs452suStCQW

Output:
{
"tx":

"030001000175c9d23c2710798ef0788e6a4d609460586a20e91a15f2097f56fc6e007c4f8e0000000000feffffff01a194
",
"collateralAddress": "HBm4FXgZXdb4NYqx1DJ3h9v9reFqYe9F6L",
"signMessage":
˓→"HEAjS5DJ9cjprZvk3t1eeq7jn2dhZztfDJ|0|HTGfMbCy2X65th3L78JVyqpzhu6p1fbSC6|HDsy8GUnsdFKWrRHB8WbD4oaLv
˓→"
}
˓→

˓→
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Next we will use the collateralAddress and signMessage fields to sign the transaction, and the output of the tx field to
submit the transaction.
Sign the ProRegTx transaction
We will now sign the content of the signMessage field using the private key for the collateral address as specified
in collateralAddress. Note that no internet connection is required for this step, meaning that the wallet can remain
disconnected from the internet in cold storage to sign the message. In this example we will again use Historia Core,
but it is equally possible to use the signing function of a hardware wallet. The command takes the following syntax:
signmessage collateralAddress signMessage

Example:

signmessage HBm4FXgZXdb4NYqx1DJ3h9v9reFqYe9F6L
˓→"HEAjS5DJ9cjprZvk3t1eeq7jn2dhZztfDJ|0|HTGfMbCy2X65th3L78JVyqpzhu6p1fbSC6|HDsy8GUnsdFKWrRHB8WbD4oaLv
˓→"

Output:
II8JvEBMj6I3Ws8wqxh0bXVds6Ny+7h5HAQhqmd5r/
˓→0lWBCpsxMJHJT3KBcZ23oUZtsa6gjgISf+a8GzJg1BfEg=

Submit the signed message
We will now submit the ProRegTx special transaction to the blockchain to register the masternode. This command
must be sent from a Historia Core wallet holding a balance on either the feeSourceAddress or payoutAddress, since
a standard transaction fee is involved. The command takes the following syntax:
protx register_submit tx sig

Where:
• tx: The serialized transaction previously returned in the tx output field from the protx register_prepare
command
• sig: The message signed with the collateral key from the signmessage command
Example:

protx register_submit
˓→030001000175c9d23c2710798ef0788e6a4d609460586a20e91a15f2097f56fc6e007c4f8e0000000000feffffff01a1949
˓→II8JvEBMj6I3Ws8wqxh0bXVds6Ny+7h5HAQhqmd5r/
˓→0lWBCpsxMJHJT3KBcZ23oUZtsa6gjgISf+a8GzJg1BfEg=

Output:
aba8c22f8992d78fd4ff0c94cb19a5c30e62e7587ee43d5285296a4e6e5af062

Your masternode is now registered and will appear on the Deterministic Masternode List after the transaction is mined
to a block. You can view this list on the Masternodes -> DIP3 Masternodes tab of the Historia Core wallet, or in the
console using the command protx list valid, where the txid of the final protx register_submit transaction identifies
your masternode.
You will probably need to wait for 1 block before your masternode will finally reaches ENABLED. Give it some time.
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Install Sentinel
Download and install Sentinel for Windows https://github.com/HistoriaOffical/sentinel/releases
Open command prompt
Create new sentinel directory in your HistoraCore directory:
mkdir cd C:\Users\<yourusername>\AppData\Roaming\HistoriaCore\sentinel

And copy sentinel.exe to the newly created sentinel directory:
cd C:\Users\<yourusername>\AppData\Roaming\HistoriaCore\sentinel\sentinel.exe

Create new file in the sentinel directory named sentinel.conf:
cd C:\Users\<yourusername>\AppData\Roaming\HistoriaCore\sentinel\

Edit file and paste the following into the sentinel.conf file:
network=mainnet
db_name=database/sentinel.db
db_driver=sqlite

Setup Task for Sentinel
Run Task Scheduler
Create Task -> General Tab - Name: Sentinal
Settings:
• Trigger Tab -> New (Trigger)
• Settings -> Repeat Daily
• Recur Every: 1 day
• Advanced Settings:
• Repeat Task Every: 1 Minute (Notice you have to select 5 minutes from the drop down, then edit the 5 to 1)
For a duration of:Indefinitely
Settings:
• Actions Tab -> New (Action)
• Program/script -> Browse to:
C:\Users\<yourusername>\AppData\Roaming\HistoriaCore\sentinel\sentinel.exe

Click Ok
Settings:
• Conditions Tab -> Power
• Uncheck box for “Start task only if the computer is on AC Power”
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Click Ok
Congratulations! Your masternode is now running. For support please come ask questions on the support channel in
the Historia Discord.

1.7 Using the Web App or Local Web App for Voting
Setting up Web App or Local Web App with your voting keys requires a basic understanding of how to use Historia
GUI Wallet and a website.
https://historia.network/

1.7.1 Before you begin
This guide assumes you are setting up your voting keys on Web App or Local Web App. This assumes that you have
already setup your masternode or voting node previously. If you have not setup your masternode or voting node, please
do that before you use this guide.
Get Your Voting Private Key
The Historia developers have tried to make this process as simple as possible for the users. On the wallet you have setup
your masternode or voting node from, click Tools > Debug console. At the console run the following commmand:
masternode status

The output will look something like this:
"proTxHash": "1656038a406384d508ebee5e1fe1fb48c5560391cd3f6b162f65575fa4c1f95a",
"collateralHash": "849bce016be646c7844587981cab8a3f64148434d20c637a3d8c4a0cc579f056",
"collateralIndex": 1,
"collateralAddress": "HVWWqYBK8bjZHrMXsz88HQxxcteqxPV7Ea",
"operatorReward": 0,
"state": {
"service": "209.250.233.69:10101",
"registeredHeight": 279634,
"lastPaidHeight": 298601,
"PoSePenalty": 0,
"PoSeRevivedHeight": -1,
"PoSeBanHeight": -1,
"revocationReason": 0,
"ownerAddress": "HPpiVzbXKtqioARFPyijdk2QaJiiFm6Xoy",
"votingAddress": "HTTM4QbcGiWAWtcJB9g22meoYupHnErcyo",
"ipfsPeerID": "Qma946d7VCm8v2ny5S2wE7sMFKg9ZqBXkkZbZVVxjJViyu",
"identity": "mn1.historia.network",
"payoutAddress": "HPi1Q925T7BjHhWndWTh5w3xvZqw5AZ7oi",
"pubKeyOperator":
˓→"1098e4f499307c4931d6d01438efe811d670226eb1e715e4ed91e78124b32c6dcd636540dc980e0cdc7272d3406ef5cb
˓→"

Find your votingAddress, collateralHash, collateralIndex. These will be needed to register your masternode in Web
App or Local Web App. In this example it is:
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"votingAddress": "HTTM4QbcGiWAWtcJB9g22meoYupHnErcyo",
"collateralHash": "849bce016be646c7844587981cab8a3f64148434d20c637a3d8c4a0cc579f056",
"collateralIndex": 1,

This next command is important to understand what exactly is happening. Normally you should NEVER run the
dumpprivkey command and give the output to a third party. But in the one instance this is safe. There should not
be any coins associated with this address. The votingAddress private key is required to use Web App or Local Web
App for voting. During the setup of your private key into Web App or Local Web App you will encrypt this within
the Web App or Local Web App application and even if the database is hacked, private voting keys will not be lost.
Alternatively you can just use the HistoriaCore GUI Wallet to vote.
Using the previous votingAddress as an example we can now get the private key of the voting address in the debug
console type in. Please use your own votingAddress key below:
dumpprivkey HTTM4QbcGiWAWtcJB9g22meoYupHnErcyo

Output:
cSh24QcuT<REMOVED FOR PRIVACY>

Add your voting address private key to Web App or Local Web App
After you have registered your user on Web App (https://historia.network/). Note: If you are using the Historia Local
Web App you do not need to register an account.
Login to the Web App application and go to Masternodes->My Masternode, as seen below.

Add your masternode details. Identity, Collateral Transaction Hash, and Collateral Index is required, as seen below. It
should be noted that Identity is just for your own records and it doesn’t matter the value.

Your masternode or voting node is now registered in the web application, however you must now uploaded your voting
private key. Click the Update button for the masternode or voting node that you want to add the voting private key to,
as seen below.
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Next enter in the your current password for the web application into the Password field. This will encrypt your voting
private key preventing anyone else from using it. Copy your votingAddress private key in to the “Voting Address
Private Key” field. Then click the Update button, as seen below.

You masternode or voting node has now been registered, your voting key has now been stored, and you can now use
this web application to vote on future proposals or records.

1.8 Using the Create system for submission of a Proposal, Record,
or Archive
How to make use of the Create module to submit a new proposal, record, or archive.

1.8.1 Before you begin
This guide assumes you have already setup an account on the https://historia.network web application or have already
setup your Historia Local Web Application (HLWA). If you haven’t done one of those things, please do that before
you use this guide.

1.8.2 How to use the Create system (Record or Proposal)
The Historia Network developers have tried to make this process as simple as possible for the users.
After you have registered your user on Web App (https://historia.network/). Note: If you are using the Historia Local
Web App you do not need to register an account.
Login to the Web App application and go to Create, as highlighted below.
Click on the Create button, as highlighted below.
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Once you click on Create, the web application will ask you which type of object you would like the create. Please
choose one of the options.

The options available:
Proposal - A proposal is a temporary object that lets voters decide the direction of the Historia Network and this
application. If a proposal passes, the Historia developers will do our best to follow the will of the voters. All proposals
will expire and be deleted from the decentralized network. Things that could be submitted as proposals listed below:
• You have a good idea, are willing to do the work, and want to get paid in HTA.
• Directions to the developers on content
• Ideas on marketing
• Directions on development or new features
Record - A record is a object that if the voters approve, then will be a permanently added to the network. Once added,
the record can never be altered, edited, or deleted by anybody, including the developers. It is 100% impossible as the
records exist on in a decentralized database that no one person owns or controls. Things that could be submitted as
records listed below:
• A current event
• Wiki content
• Useful information that should always be maintained forever.
Archive - An archive is a subset of a record object with the same behavior from a voting perpsective with regards
to blockchain locks. When choosing an archive object, this will trigger functionality within the web application to
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archive an external web page.
If you choose a Proposal or Record object you will be asked if you would like to import a template to work off of, as
seen below.

It is recommended that you use a template, unless you have enough skill to create a custom page.
Once Create Builder interface loads there is much going on here as seen below
Key for above screen shot:
1. Type of object you are working on
2. End Cycle Date - This is the date of the next superblock and payment to any passing objects. It’s recommended
that you submit your object with at much voting time left possible to gain votes.
3. Next Payment Date - How many days left before the next superblock and payment to any passing objects
4. Voting Deadline Date - How many days left that masternodes and voting nodes have to vote on this proposal.
The last two days of the cycle nodes can not vote.
5. Currently Passing - This is the total amount of HTA for the objects that have enough votes to pass currently. If
too much HTA is allocated to pass in the current cycle, your object may not be paid even if it passes. This field
is important to consider when putting in a object.
6. Total Available Budget - This is the total amount of HTA available for objects per month.
7. Name - This is the name that will be seen on the blockchain of your object.
8. Summary - This is the summary that will be seen on the blockchain of your object.
9. Reward Address - This is YOUR address that you want coins to be paid to, if your object has enough votes to
pass.
10. Reward Amount Requested - The amount you are requesting if your object passes.
11. Editor - This is where you can edit the content of your object.
12. Editor Toolbar - This is where you can change formatting and create your object. Please get familar with this,
as there is much involved here.
13. Save Button - This button allows you to save a draft without submitting your object to the blockchain. Your
work it not automatically saved. Save often.
14. Delete Draft - This button will delete this draft.
15. Submit Button - Once you are complete and are ready to submit your object for a vote hit this button. Note, after
you hit this button you will not be able to make changes.
After you hit the submit button, you will be asked for payment for your object as seen below.
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After the payment is received your object has been submitted to the network. It may take up to 1 hour for the blockchain
to process and sync your object for vote.

1.8.3 How to use the Create system (Archive)
Once you click on Create, the web application will ask you which type of object you would like the create. In this case
choose the Archive option.

After choosing the Archive option, it will pull up the Create Builder screen, but slightly different than above. If you
have not yet installed the Historia Network Browser Extension you will see the screen below. You can learn how to
install the browser extension here.
If using the Historia Local Web Application (HLWA) you are ready to import and Archive. If you are using the Historia
Network main web application (https://historia.network), you must setup your API Key for the browser extension to
be able to import. To setup your API Key, go to https://historia.network/apikeys and click the generate button. It will
produce your individual API key as seen below.
After you have setup your API Key in the Historia Network main web application, you must set the API Key in the
Historia Network Browser Extension. Right click on the Historia Network Browser Externsion and open the Options
menu. This will bring up the settings for the extension as seen below.
Paste in your API Key into the Historia Network API Key field and close the settings tab. Your API Key has now been
setup. After installing and have setup your API Key go back to the Archive page. You will see the following prompt
when opening up the Archive page.
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When that prompt is shown in either the HLWA or the Historia Network main web application (https://historia.
network) open a new tab in your browser of a page that you want to import into the archive page. Right click on
the page and go to Historia Network in the dialog menu, either select the “Send Page to Historia Network (Live)” if
you want to use the main web application or “Send Page to Historia Network (Local)”. If you choose the local version,
the HLWA must also be running first.
After selecting the “Send Page to . . . ” option, go back to the Archive page. Depending on the complexity of the page
in question this can take a few seconds to import. View the imported page below.

It should be noted that for some pages it is not possible to take a screen shot and only the HTML version or the archive
will be available in the Preview area. If this occurs, you can still submit the HTML version of the Archive as an object.
Trouble Shooting
1. Historia Network main web application (https://historia.network) archive page does not import page
• Regenerate your API Key (https://historia.network/apikeys)
• Save regenerated API Key in the Historia Network Browser Extension
• Verify that you are using the “Send Page to Historia Network (Live)” option.
2. HLWA archive page does not import page
• Restart Browser
• Restart the HLWA app on your local machine
• Verify that you are using the “Send Page to Historia Network (Local)” option.

1.9 Setup the Historica Local Web Application
Setting up a Historica Local Web App requires a basic understanding of how to use a computer, as well as an ability
to follow instructions closely.

1.9.1 Before you begin
This guide assumes you have already setup your voting node. You will need:
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• Historia Core Wallet v0.17.0.3 or later to store your Historia. You can get this here.
• .NET Core Libary for your Operating System. You can get this here.
• A computer running Windows, MacOS, or Linux.
• The Historia Local Web Application Software. You can get this here.
• (Optional) A masternode or voting node previously setup if you want to use Historia Local Web App for voting.
You can learn to setup a voting node here or a masternode here.
In this guide, we will assume you will be working from a Windows computer. However, alternative steps for using
MacOS or Linux will be indicated where necessary.

1.9.2 Setup the Historia Core for Local Web Application Access
Open the Historia Core wallet config file, historia.conf. For different operating systems, the Historiacore folder and
the historia.conf file can be found in the following locations.
Platform
Linux
OSX
Windows

Path

Shortcut

/home/yourusername/.historiacore
/Macintosh
HD/Library/Application
Support/HistoriaCore
C:/Users/yourusername/AppData/Roaming/Historia
Core

~/.historiacore
~/Library/Application
port/HistoriaCore
%APPDATA%Historia Core

Sup-

Setup RPC access in the config file
Once the historia.conf file is open add the following lines to the historia.conf config file. Make sure to choose a unique
rpcuser and rpcpassword:
rpcuser=<YourUsername>
rpcpassword=<YourPassword>
rpcport=10100
rpcthreads=8
rpcallowip=127.0.0.1
server=1

Save the historia.conf file, and start or restart the Historia Core Client if it is currently running.

1.9.3 Setup the Web Application
If you haven’t already, download the Historia Local Web Application for your platform. You can get this here.
Unzip the directory on to your desktop or location where you want it to run from. If in Linux untar instead of zip.
Open the HistWeb.exe executable by double clicking on the icon, as seen below.
If in Linux before you can run the Historia Local Web Application you must set the file to have executable permissions
then to run in Linux:
chmod +x HistWeb
./HistWeb

To run the Historia Local Web Application in OSX:
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dotnet HistWeb.dll

Once run the application you will see the local address in the command prompt that you need to connect to, as seen
below.

Command Prompt with Local Address
Copy this address and paste it into your browser. This will open the web application in your browser. If it is your first
time, it will take you to the setup screen, as seen below.
Setup Screen
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Add your Historia Core Client information that you used in the historia.conf file. and click the “Test Connection to
Historia Client” button. If the connection is successful you will see a Sucess message, as seen below.

Successful connection to Historia Core Client
Add IPFS gateway information with the proper port (ie 443). You can choose any IPFS gateway. Any masternode here
with IPFS/Web set with Yes/Yes can be used. Alternatively you can use gateway.ipfs.io with port 443. Click the “Test
Connection to IPFS Server” button. If the connection is successful you will see a Sucess message, as seen below.
Successful connection to IPFS
Once the Historia Core Client and IPFS Gateway are setup, hit the save button to save all settings.
Successfully saving settings
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The Historia Local Web Application is now setup and you can browse the proposals and records, as seen below.

If you want to use the Historia Local Web Application for voting, you have to setup your voting keys. Follow the Web
App voting guide here. It is the same process.
Multiple Masternode / Voting Nodes
You can add multiple masternodes or voting nodes and this will vote with all keys properly. The one caveat is that the
passphrase you use in the web application must be the same accross all masternodes / voting nodes.
Trouble Shooting
1. Can not connect to Historia Core Client - Check to make sure Historia Core Client is running. - Check to make
sure that your historia.conf configure file has the correct rpc settings
2. Can not connect to IPFS Gateway - Check to make sure you have a valid IPFS server in the settings page. Check to verify the port is set properly. This is normally port 443.
3. No records or proposals are seen. - Make sure that the Historia Core Client is synced completely. - Make sure
that you have a valid IPFS Gateway server.
4. Voting Issues - Have you added your masternode / voting nodes to Historia Local Web app? - Multiple Masternodes / Voting Nodes must have all the same password. - Make sure you have updated your registered masternode
/ voting node in the Historia Local Web Application with your VotingAddressPrivateKey. Follow the Web App
voting guide here again.
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